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حق نشر

شما می توانید با رعایت نکات زیر آزادانه از مطالب این کتاب استفاده کنید:

ذکر منبع را فراموش نکنید..1

چنانچه مطلبی اضافه کردید آن را نیز آزادانه در اختیار قراردهید..2

پدید آورندگان
برای این نگارش

حجت‌اله مداحی

برای نگارش‌های قبلی

شرکت دانش‌بنیان سامانه‌های آزاد فناوری اطلاعات ایده‌آل آینده ایرانیان )سافا(

بازخورد
 بهدر خصوص این کتاب را به طور مستقیملطفا هرگونه پیشنهادها، انتقادها و بازخوردها و نکات خود 

  ارسال فرمایید.goodlinuxuser@chmail.irرایانامه 

تاریخ انتشار و نسخه نرم افزار
۷.۱ میلادی( بMMرای نسMMخه ۲۰۲۱هجری شمسMMی و ۱۴۰۰)۱۴۴۲این راهنما همزمان با عید غدیر 

آغاز شد.

ممکن است در سایر نسخه مقداری تفاوت وجود داشته باشد.

تقدیم به سیدالشهداء، حضرت اباعبدالله الحسین و  ارواح طیبه همه شهدا که آزادگان جهانند.
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راهنمای شروع به کار با لیبره آفیس-رایتر

مقدمه
 فصل بود اما مفاهیم اصلی و مورد نیاز که عموما در سرفصMMل هMMای۲۰کتاب اصلی 

ICDL ،ابد فصل را شامل می شد. ۷  در نظر گرفته می شودMMدی کتMMل بنMMر فص
ترتیب کتاب اصلی در نظر گرفته شد.



این کتاب برای چه افرادی است؟

لیبره آفیس یک مجموعه نرم افزار اداری پرکاربرد، آزاد، متن‌بMMاز اسMMت کMMه شMMامل چنMMدین برنامMMه
هMMای داده و فرمMMول نویسMMیپایگاه‌قدرتمند برای واژه پردازی، صفحات گسترده، ارائه‌ها، گرافیک‌ها ، 

است.

رایMMتر یMMک نMMرم افMMزار واژه پMMرداز اسMMت کMMه بMMا قMMالب هMMای متنMMوع از جملMMه مایکروسMMافت ورد)
doc,  .docx هMالب ازجملMدین قMود را در چنMار خMسازگار است و شما می‌توانید ک ) .pdfروجیMخ 

بگیرید.

 خواهMMدیافت.ارزشمندهر فردی که می خواهد به سرعت بالا در  در کار با  رایتر برسد این کتاب را  
شما ممکن است در استفاده از نرم‌افزار واژه پرداز تازه کار باشید یMا ممکن اسMت بMا دیگMر مجموعMه

نرم‌افزارهای اداری آشنا باشید.

چه چیزی در این کتاب است؟

 را۷.۱این کتاب ویژگی‌ها و امکانات اصلی رایMMتر یعMMنی بخش واژه پMMرداز از مجموعMMه لیMMبره آفیس 
معرفی می کند و دستورالعمل استفاده از آن را فراهم می‌سازد.

یادداشت

نسخه های برخط و دیگMMر نسMMخه هMMا نوشته شده است؛ ۷.۱این کتاب برای نسخه 
ممکن است از آنچه در این کتاب توضیح داده شده است  در ظMMاهر و عملکMMرد کمی

متفاوت باشد.
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لیبره آفیس را از کجا بگیرم؟

برای لینMMوکس، وینMMدوز و مکینتMMاش بMMه طMMور رایگMMان و آزاد در لیبره آفیس نسخه های مختلفی از  
در دسترس است. کاربران https://www.libreoffice.org/downloadدسترس است و از نشانی  

لینوکس همچنین نسخه متناسب با توزیع های مخلف لینوکس را خواهندیافت. در صMMفحه بMMارگیری
نسخه قابل حمل)بدون نیاز به نصب( و نسخه های دیگر فهرست شده است. 
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راهنمای شروع به کار با لیبره آفیس-رایتر

۱فصل 
آشنایی با محیط برنامه



معرفی-رایتر چیست؟

 واژه پرداز مجموعه آزاد و پر امکانات لیبره آفیس آزاد است. به عبMMارتی بMMرای  امکانMMاتبخشرایتر 
معمول یک واژه پرداز)درج متن، ویرایش و قالب بندی،صفحه آرایی، بررسMMی کننMMده دسMMتور زبMMان،

فرهنگ جامع و تصحیح خودکار؛ جستجو و جایگزینی؛ و…( رایتر امکانات فوق‌العاده‌ای دارد.

(word processor)واژه پرداز 

رم‌افزاری است که از آن برای ایجاد، ویرایش، صفحه آرایی و تولید صMMفحات متMMنین
استفاده می‌شود که البته ممکن است شامل تصاویر و اشکال گرافیکی نیز باشد.

صفحه آرایی

به آرایش متن، نحوه چیدن تصاویر، حاشیه بندی صفحات و تنظیمات چاپ، صفحه
آرایی گفته می‌شود.

اجزای پنجره اصلی رایتر

 نشان داده شده است که در این بخش در مورد آن توضیح داده۱ شکل شماره پنجره اصلی رایتر در 
شده است.

یادداشت

به طور پیش فرض، دستورات رایتر لیبره آفیس همان طور که در این بخش توضMMیح
رایتر بMMرای دسترسMMی بMMهداده شده است در منوها و نوارابزارها گروه بندی شده اند. 

ابزارها و دستورات، هفت رابط کMMاربری  متنMMوع از جملMMه روبMMان کMMه مشMMابه آن در
viewمایکروسافت ورد وجود دارد را از طریMMق منMMوی  ...  →  User  Interface

فراهم آورده است.
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 نوار عنوان
Titleنام لاتین آن   Barاری در آنMده جMام پرونMه نMراردارد کMاست و در بالاترین قسمت پنجره ق 

 را ذخMMیره نکMMردهآن تMMاکنونمشاهده می شود.در صورتی که پرونده جاری نامی نداشته باشد یعMMنی 
)بی عنوان( را مشاهده خواهید کرد.untitledباشید 

نوار منو
Menuنام لاتین آن   BarتمMMت و در سیسMMاست و جای آن در لینوکس و ویندوز زیر نوارعنوان اس  

عامل مک بالای صفحه نمایش است. موقعی که شما یکی از منوها را انتخاب می‌کنید یک زیرمنو باز
می شود که گزینه های بعدی را نمایش می دهد از جمله:

( درSave( یMMا ذخMMیره)Closeفرامینی  که بلافاصله عملی را انجام می دهند مانند بستن)•
(Fileمنوی پرونده)

فرامینی که پنجره‌های محاوره ای را باز می‌کنند کMه بMا سMه نقطMه در ادامMه فرمMان قابMل•
تشخیص هستند، مانند

... Find and Replace(در منوی ویرایش Edit)

فرامینی که زیرمنوهای بعدی را باز می کند. آن‌ها با پیکان کوچکی  مشخص هستند که در•
(. بMMاView در منMMوی نمMMا)Zoom( و Toolbarsادامه فرمان آمده است، مانند نوارابزارها)

 مکان نما روی آن ها، زیرمنو باز می‌شود.بردن 
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جانبینوار 
 نشان داده شده است  به طور معمول  ] بMMه۱ است و همان طور شکل شماره Sidebar نام لاتین آن

طور پیش فرض در زبان های راست به چپ مانند فارسی، سمت چپ و در لاتین سمت راسMMت[  در
کنار پنجره رایتر باز است.

  در نوار ابزار می توانید آن را ظاهر یا مخفی کنید.همچنینSidebar←در صورت لزوم از منوی نما  
 دیده می شMMود، دکمMMه ای در کنMMار خMMود  بMMرای نمMMایش۲نوار کناری همان طور که در شکل شماره

دادن/مخفی کردن دارد.
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(، صMMفحه)Properties دسته است: خصوصMMیات)۶نوارکناری رایتر به طور پیش فرض مشتمل برا 
Page(بک‌هاMMس ،)Styles(هMMنگارخان ،)GalleryاوMMبر)(، نNavigator(بکMMازرس سMMو ب ،)Style

Inspector  نوار  باز می شود. کناری( است.هر دسته با کلیک رو شمایل مربوطه 

یک تابلو ترکیبی از نMMوارابزار و پنجMMره‌ محMMاوره‌ایهر دسته شامل نوار عنوان و محتویات تابلوهاست.
است. نوارابزارها و تابلوهای نوارکناری کاربردهای زیادی به اشتراک می گذارنMMد. بMMه عنMMوان مثMMال،

( می کند  هم در نوار ابزار قالب بندی در پنجMMره اصMMلیitalic(یا مایل)Boldشمایلی که متن را توپر)
( در دسته خصوصیات.Character panelوجود دارد و هم در تابلو نویسه)

رای هماهنگ کردن عMMرض نوارکنMMاری، نشMMانگر موشMMی را دیMMواره بین فضMMای کMMاری و نوارکنMMاریب
قراردهیدو هرگاه شکل نشانگر به پیکان دو طرفه تغییر کرد، کلیک کنید و به راست یا چپ بکشMMید.
اما این کار کارایی چندانی ندارد چراکه برخی از دسته های با توجه بMMه محتویMMات آن از حMMد معیMMنی

کم‌عرض تر نمی شوند.
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یMا بMه شناور کنیMد از گوشه پنجره اصلی جدا کنید و به عبارت دیگر آن رابرای این که نوار کناری را 
گوشه دیگر پنجره وصل کنید از فهرست کشویی تنظیمات نوار کناری واقع در بMMالای نMMوار اسMMتفاده

 را ببینید(۳کنید.) شکل شماره

ز همیناباشMMد هم می توانیMMد فعMMال برای انتخاب این که می خواهید چه زبانه هMMایی در نوارکنMMاری 
فهرست  استفاده کنید.

جانبیدسته‌های نوار 
 در نوار کناری در زیر شرح داده شده است.شامل شدهدسته‌های 

 حاوی ابزارهایی برای قالب‌بندی مستقیم محتواست.(:Propertiesدسته خصوصیات)

زمانی که یک متن انتخاب شده باشد این تابلوها ظاهر می شوند::

(: اعمال، ایجاد یا به روزرسانی سبک یک بند.Stylesسبک‌ها)–

(:اصلاح خصوصیات متن مانند نام قلم، اندازه، رنگ، وزن یا فاصله بین نویسه‌ها.Characterنویسه)–

(: اصلاح ترازبندی بند، رنگ پس زمینه، تورفتگی، فاصله و شماره یا علامتگذاریParagraphبند)–
فهرست‌ها.

 یا گرافیک انتخاب شده باشد این تابلوها ظاهر می شوند:تصویرزمانی که یک 

اصلاح نحوه پر بودن رنگ و شفافیت پس زمینه تصویر(: Areaناحیه)–
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حالت رنگ، و شفافیت.( رنگ، contrast : اصلاح روشنایی، تضاد)(Imageصویر)ت–

 به متن دور آن.با توجه (: اصلاح موقعیت شکل یا تصویرWrap لفافه)–

دوران یا برگرداندن(:اصلاح پهنا، ارتفاع، Position and Sizeموقعیت و اندازه)–

زمانی که شی رسم شده انتخاب شده باشد این تابلوها ظاهر می شوند:

اصلاح نحوه پر بودن رنگ و شفافیت پس زمینه تصویر(: Areaناحیه)–

 هماهنگی درخشش یا لبه های نرم و شفافیت  پس زمینهیا(:افزودن Effectجلوه)–

خط: اصلاح پیکان ها، سبک خط، پهنا، رنگ و شفافیت پس زمینه–

دوران یا برگرداندن(:اصلاح پهنا، ارتفاع، Position and Sizeموقعیت و اندازه)–

زمانی یک چارچوب انتخاب شده باشد این تابلوها ظاهر می شوند:

اصلاح نحوه پر بودن رنگ و شفافیت پس زمینه تصویر(: Areaناحیه)–

دوران یا برگرداندن(:اصلاح پهنا، ارتفاع، Position and Sizeموقعیت و اندازه)–

 که  چهار تابلو دارد:صفحه استحاوی ابزارهایی برای قالب‌بندی مستقیم (:Pageدسته صفحه)

(:اصلاح اندازه،پهنا، ارتفاع،جهت و حاشیه های صفحه.Formatقالب)–

سبک‌ها: اصلاح سبک شماره گذاری صفحه، پس‌زمینه، چیدمان و تعداد ستون‌ها.–

(:فعال/غیرفعال کردن سرصفحه و اصلاح حاشیه ها، فاصله ها و محتویاتHeaderسرصفحه)–

 اصلاح حاشیه ها، فاصله ها و محتویاتپاورقی و (:فعال/غیرفعال کردن Footerپاورقی)–

احتیاط

 تغییراتی که در گزینه های دسته صفحه، شما سMMبک صMMفحه در حMMالبا آگاه باشید 
استفاده را تغییر خواهید داد، اصلاح نه فقط برای صMMفحه جMMاری بلکMMه بMMرای همMMه

صفحاتی است که در این سند از این سبک استفاده می کنند.

مدیریت سبک‌های استفاده شده در(: Styles and Formattingدسته سبک‌ها و قالب بندی)
سند، اعمال سبک‌های موجود، ایجاد سبک‌های جدید یا اصلاح آن‌ها.
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 نگارخانMMه. نگارخانMMه دو بخشتم‌هMMاینمایش تصاویر و نمودارها در (:.. Galleryدسته نگارخانه)
تم ها بر اساس نام )پیکان‌ها، گلوله ها، نمودارها و غیره( و دومی نمMMایشدارد: اولی فهرست هایی از 

تصاویر مربوط به تم انتخابی.

کاوش سند و تشخیص محتوای آن بر اسMMای انتخMMاب دسMMته بنMMدی(:Navigatorدسته ناوبری)
برای اطلاعات بیشتر کار بMMا نMMاوبری درمحتوا از قبیل سرفصل‌ها، جدول‌ها، قاب‌ها، تصاویر و غیره. 

صفحات بعد را مطالعه بفرمایید.

نمایش همه ویژگی‌ها سبک‌های بند، سبک‌های نویسه،(:Style Inspectorدسته بازرس سبک)
و قالب بندی دستی متن انتخاب شده.

نوارابزارها
لیبره آفیس دو نوع جایگاه نوارابزار دارد: ثابت و شناور.در حالت ثابت نوارابزارها می تواند به جاهای
مختلفی جابجا شود)مثلا بالا، پایین یا کنار فضای کاری( و حتی شبیه یک پنجره مسMMتقل،  شMMناور در

هر جای صفحه که خواستید قرارگیرند یا دوباره در قسمتی از صفحه، ثابت شوند.

آشکار یا پنهان کردن نوارابزارها
 برویMMد و روی نMMام هMMر← نم..ا نواره..ای اب..زاربرای آشکار یا پنهان کردن نوارابزارها، از نوار منو به

نوارابزاری که مدنظر دارید کلیک کنید تا با علامت دار شدن یMMا برداشMMتن علامت آن نMMوارابزار بMMه
هدف خود برسید.

برای مخفی کردن یا به اصطلاح بستن نوارابزار راه دیگری هم وجود دارد و آن کلیک راسMMت کMMردن
 که آخرینه گزینه از منویی است که باز  می بستن نوارابزارروی فضای بین دو آیکن و انتخاب گزینه

شود.

نوار ابزارهای پرکاربرد
(۱در  لیبره آفیس به طور پیش فرض اولین نوارابزاری که زیر نوارمنو دیده می شMMود)شMMکل شMMماره 

نوارابزار استاندارد خوانده می‌شود.
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( است که اگر شکل یاFormatting toolbarدومین نوارابزار پرکاربرد در بالا نوار ابزار قالب بندی) 
تصویر انتخاب شود مخفی می شود و نوارابزار ویژگی های مربوط به تصMMویر یMMا شMMکل نمMMایش داده

می‌شود.

برای داشتن فضای بیشتر می توانید همان طور که قبل تر گفته شد این دو نMMوارابزار را ببندیMMد و بMMه
← نما  نوار ابزارها  جای آن از منوی ←standard(single mode) را انتخاب کنید که شامل

ابزارهای پرکاربردتر این دو نوار ابزار است.

زیرمنوها و جعبه ابزارها
شمایل‌های روی نوار ابزار که مثلث کوچکی کنارشان است زیرمنو یا جعبه ابزار  بیشتری مربMMوط بMMه

آن ابزار دارد.

یک جعبه ابزار  مجموعه‌ای از ابزارهای ضمیمه به یک ابزار است مثلا وقتی روی مثلث کوچک ابزار
شکل بزنید جعبه ابزار شامل انواع اشکال مشاهده خواهدشد. یک جعبه ابزار را همMMان طMMور کMMه در

 می‌بینید می توان  به عنوان یک نوار ابزار شناور باز نگه داشت. جعبه ابMMزار جMMدا شMMده نMMیز۴شکل 
دارای نوار عنوان است و  می توانید شبیه دیگر نوارابزارها آن راجابه جا یا  ثابت کنید.
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جابه‌جایی نوارابزارها
می توانMMد بMMه متصل در همان حMMالت هرچند می تواند از حالت ثابت خارج شود، ثابتنوارابزارهای 

 جابجا شود. چپ یا راست

برای جداکردن نوار ابزار:

 نشان داده شده۵نشانگر موشی را روی دستگیره‌های نوارابزار ببرید)نوار عمودی کوچک ابتدای نوار ابزار که در شکل (1
است(

دکمه کلیک را پایین نگه دارید و نوار ابزار را به محل جدید بکشید.(2

دکمه موشی را رها کنید.(3

برای انتقال نوارابزار شناور-شبیه سایر پنجره ها-روی نوار عنوان کلیک کنید و به محل دیگر بکشید
یا اگر خواستید آن را به بالا یا پایین پنجره اصلی متصل کنید.

یادداشت

شما همچنین می‌توانید برای ثابت یا به عبMMارتی متصMMل کMMردن نMMوارابزار، روی نMMوار
عنوان آن دوبار کلیک کنید.

نکته

اگر دستگیره‌های نوارابزار دیده نمی‌شود موقعیت آن قفل شده است.برای بازکردن،
Lockقفل کردن موقعیت نوارابزار)روی آن کلیک راست کنید و سپس گزینه 

Toolbar Position).را از حالت انتخاب خارج کنید 

آشنایی با محیط برنامه۱فصل  | 18

: دستگیره‌های نوارابزار۵شکل 



خط‌کش‌ها
خط‌کش افقی در عرض بالای فضای کاری به طور پیش‌فرض مشاهده می‌شود اما خط‌کش عمMMودی

نما < خط‌کش‌ه..ا)به طور پیش‌فرض مخفی است. برای فعال کردن خط‌کش عمودی، از نوار منو، 
Rulersاب کنید ( < خط‌کش عم..ودیMMا از را انتخMMابزار‌ه..ا < گزینه‌ه..ا… <  ی LibreOffice

Writer > خط‌کش عمودی)نما ،Virtual rulerیا مخفی ( را علامت بزنید.برای به سرعت ظاهر 
 استفاده کنید.Ctrl+Shift+Rکردن هر دو خط‌کش از کلید ترکیبی 

نکته

دارد؛ اگMMر بMMرایود ( در انتهای خcommentsخط‌کش افقی یک دکمه توضیحات)
برخی بخش‌های سند توضیح درج شده باشد با کلیMMک روی این دکمMMه بMMه سMMرعت

قسمت توضیحات مخفی یا آشکار می شود.

نوار وضعیت
نوار وضعیت رایتر در پایان فضای کاری قرار دارد و اطلاعاتی درباره سند و راه‌های راحتی برای تغییر
سریع برخی ویژگی‌های سند فراهم می کند. این نوار می تواند از منوی نما با خارج کردن از انتخاب،

مخفی شود.

کلیدهای میانبر محیط کار
 کلید‌های میانبریدر لیبره آفیس هم شبیه سایر برنامه هابرای دسترسی ساده تر و سریع تر به فرامین

تا بدون نیاز به حرکت موشی بتوانید سریع تر فMMرامین مMMدنظر خMMود راهم در نظر گرفته شده است. 
(Save در لیبره آفیس و بیشتر برنامه‌های کMاربردی کلیMد میMانبر ذخMMیره)Ctrl+sاجرا کنید. مثلا 

است.

کلید میانبر فرامینی که در منوها مشاهده می شود رو به روی نوشته شده است.

19 | اجزای پنجره اصلی رایتر



یادداشت

در رابط کاربری فارسی کلیدهای کنترلی صفحه کلید هم ترجمه شMMده انMMد! مثلا بMMه
Shift در نام کلیدمیانبر کلمه مهار را مشMMاهده خواهیMMد کMMرد.)بMMه جMMای Ctrlجای 

 دگرساز.Altتبدیل  و به جای 

نکته

و حرف زیرخط دار منو یا زیر منوی مربوطه می توانید بMMه آن  Alt با فشردن کلید 
  را برایFile  هم منوی F  و Altمنو دسترسی داشته باشید. مثلا فشردن  کلیدهای 

شما باز می کند و فشردن حرف زیر خط دار زیرمنوها مشMMابه کلیMMک روی آن عمMMل
خواهدکرد.

Altدر صفحه کلید استاندارد فارسی 

(Altبرای نکته قبل در هنگام فارسی بودن صفحه کلید ممکن اسMMت فقMMط دگرسMMاز)
سمت چپ کار کند چراکه در صفحه کلید استاندارد فارسی کلیدها سه حالت دارند،

( فشرده شوند که معمولا برای اعراب وShift حالتی که با تبدیل)۲: حالت عادی، ۱
(سMMمت راسMMتAlt حالتی کMMه بMMا دگرسMMاز)۳علایم)ویرگول و …( استفاده می شود، 

فشرده شوندکه در این حالت می توان علائم لاتین را بدون لاتین کردن صفحه کلید
ظاهر کرد یعنی بدون این که برای نوشتن@ بدون این که صفحه کلید را لاتین کنید

 را بنویسید و دوباره صفحه کلید را فارسMMی کنیMMدعلامت این ۲ ‌و عددShiftو بعد با 
 به سادگی این کار را انجام دهید.۲ سمت راست و عدد Altمی توانید با 

ایجاد سند جدید خالی

شما از چندین طریق می‌توانید یک سند جدید یا خالی در رایتر ایجاد کنید. 
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از مرکز شروع
 (دیده می شود.۶هنگامی که لیبره آفیس باز است اما سندی باز نیست، مرکز شروع)شکل شماره

البته همان طورCreate: Writer Document روی   کلیک کنید تا یک سند متنی ایجاد شود؛ 
قالبیتا  هم  می توانید کلیک کنید Templates بیشتر توضیح داده خواهدشد روی  کمی بعد، که 

غیر از قالب پیش فرض برنامه برای سند جدیدتان انتخاب کنید.

نوار منو، نوارابزار یا صفحه کلیداز 
اگر رایتر باز باشد شما از سه راه دیگر می توانید سند جدید ایجاد کنید:

Ctrl+Nفشردن کلید ترکیبی •

 (از نوار منوFile > New > Text Document ) متنینوشتارپرونده < جدید < انتخاب •

 روی نوارابزار استاندارد(New icon جدید )کلیک روی شمایل •
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(Template موجود)الب‌هایایجاد سند جدید بر اساس ق

(است. قMMالب،Templateیکی از قابلیت‌های رایتر برای تسریع در کارهای تکراری استفاده از قالب)
 متن، قالب بندی، سبک، تصاویر پس زمینMMه ومجموعه‌ای از پرونده ای ویژه‌ای  است که  می تواند 

 قابل استفاده است)شبیهمشابه باشد و مثل یک فرم خام برای کارهای مشابه  یا تکراری سایر موارد 
قابل استفادهنامه‌های اداری با سربرگ مشخص(.  سبک‌ها و تنظیماتی است که در ایجاد سند جدید 

.مزیت استفاده از قالب برای ایجاد سMMند جدیMMد این اسMMت کMMه تنظیمMMات و طMMراحی ظMMاهریاست
سندجدید مشابه قالب انتخاب شده است و نیاز به طراحی و تنظیمات مجدد نیست.

برای بازکردن پنجره قالب‌ها، به این یکی از این روش‌ها اقدام کنید:

Ctrl+Shift+Nاستفاده از کلید میانبر  •

< File > Templates < مدیریت قالب‌ها از نوار منو)Templatesانتخاب پرونده < •

Manage Templates)

(File > New > Templatesانتخاب پرونده < جدید < قالب‌ها از نوار منو)•

( روی نMMوارابزار اسMMتاندارد وNew iconکلیMMک روی مثلث کوچMMک شMMمایل جدیMMد)•
Templatesانتخاب  ...

 قالب های مربوط به نوشتار)سندهای های متMMنی( مشMMخص۷نمونه نشان‌داده شده در شکل شماره
است. کافیست روی قالب دلخواهتان دوبار کلیک کنید تا سندی با آن قالب ایجاد شMMود. همچMMنین

 کلیک کنید.(Openبازکردن)می‌توانید یک قالب انتخاب کنید و روی دکمه 
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مدیریت اسناد

پس از اسند جدید و تکمیل آن، لازم است یجاد یک اسنادی که در سند را ذخیره کنیم یMMا ببنMMدیم.
همچنین ممکن است در آینده بخواهیم مجددا نوشتار را در رایتر باز کنیم.

ذخیره کردن سند
Save ذخ..یره ب..ا عن..وان...) یا فرمان(Save ذخیره)شما می‌توانید یک نوشتار را با فرامین  as)

ذخیره کنید.
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فرامین ذخیره سازی

ذخیره پرونده جدید یا پرونده از قبل ذخیره شده
یکی از کارهای زیر را انجام دهید:

.Ctrl+Sفشردن •

(File > Save از نوار منو) پرونده < ذخیرهانتخاب•

 ( روی نوارابزار استاندارد.Save icon)ذخیرهکلیک روی شمایل •

نکرده باشید، با انجام هر یک از گزینه‌های فوق، پنجره ذخیره به عنوان) نوشتار جدیدتان ذخیره  اگر
Save  asازی آن راMMیره سMM( باز می شود. نامی برای پرونده وارد کنیدو از نوع)پسوند( و محل ذخ

 کلیک کنید.ذخیرهبازبینی کنید و روی 

پس از این که سند را ذخیره کردیم، ممکن است مجددا تغییراتی را در آن اعمال کنیم. بهMMتر اسMMت
چر چند دقیقه  یکبارسند را ذخیره کنیم تا در صورت ایجاد مشکلی مانند قطع شدن برق، تغیMMیرات

داده شده از بین نرود.

برای ذخیره پرونده جاری نیز به همان ترتیب گفته شده عمل می کنیم:

.Ctrl+Sفشردن •

(File > Save از نوار منو) پرونده < ذخیرهانتخاب•

 ( روی نوارابزار استاندارد.Save icon)ذخیره کلیک روی شمایل •

بدیهی است اگر نوشتار را از قبل ذخیره کرده باشید پس از انجام هر یک از گزینه‌های بالا، برای نMMام
 نیست و پرونده با همان نام و نوع در همMان محMل فعلیاضافه تریو نوع و محل پرونده نیاز به کار 

ذخیره خواهدشد.

پرونده جاری

سندی  که هم اکنون در داخل آن قرار داریم و نام آن در نوار عنMMوان)بMMالای پنجMMره(
مشخص است را پرونده جاری می‌گوییم
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(Save a copyذخیره یک رونوشت)
وقتی استفاده کنید که می‌خواهید سند فعلی باز بماند و و رونوشMMت جداگانMMه ای هم ازاز این دستور 

نگارش فعلی ذخیره کنید.

Save As را که انتخاب کردید، پنجره محاوره‌ای Save a Copyوقتی از نوار منو،  پرونده <  ...

ظاهرشد، نام، نوع و محل را وارد یا تایید کنید و سپس روی ذخیره کلیک کنیMMد. رونوشMMت ذخMMیره
شده باز نمی شود و پرونده اصلی باز و فعال باقی  می‌ماند.

ذخیره همه
این فرمان همه پرونده های باز را ذخیره می‌کند.

را انتخاب کنید تا بدون تغییر در نام، نوع یا( File > Save All پرونده < ذخیره همه)از نوار منو،
محل ذخیره‌سازی همه پرونده‌های باز  ذخیره شوند.

(Save asذخیره به عنوان )
 جدید با نام یا نوع یا محل ذخیرهسندی فعلی را به عنوان نگارش گاهی اوقات ممکن است بخواهیم

سازی دیگری ذخیره کنیم. برای این کار به صورت زیر عمل می‌کنیم:

File پرونده < ذخیره به عنوان)از نوار منو،   >  Save  As )انبرMد میMدیا کلیMاب کنیMرا انتخ
Ctrl+Shift+S را بزنید تا پنجره ذخیره باز شود، سپس نام یا نوع یا محل جدید را مشخص کنید و

در نهایت روی ذخیره کلیک کنید.

(Save as ) و ذخیره به عنوان(Save a copy)فرق ذخیره رونوشت

وقتی ذخیره به عنوان را انتخاب می کنید نگارش فعلی جداگانه ذخیره خواهد شد با
این تفاوت که پرونده اصلی با آخرین ذخیره‌سازی قبلی بسته می‌شود و سندی که باز
است در واقع سند جدید ذخیره شده است.اما در ذخیره یک رونوشت همان طور که
گفته شد تغییرات تا آن لحظه در پرونده ای دیگر ذخیره می شود بMMدون این‌کMMه بMMاز

شود و شما می توانید ادامه تغییرات را شما در پرونده اصلی انجام  دهید.
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یادداشت

PDFلیبره آفیس از عبارت »صدور« برای خروجی گرفتن در قالب‌های دیگر ماننMMد 

 استفاده می‌کند.ePubو 

بازکردن سند
 از چندین راه می توانیم اسناد موجود را باز کنیم، از جمله:

 از مرکز شروعRemote files ا  یOpen File  کلیک روی •

 از نوار منو.File > Open Remote یا ( File > Open.)   پرونده < بازکردن..انتخاب•

.Ctrl+Oفشردن  •

روی نوار ابزار استاندارد.( Open iconکلیک روی شمایل بازکردن)

 را مشMMخص می کMMنیم ودر صورت نیاز محل و نوع پرونMMدهد، ابتدا شهنگامی که پنجره بازکردن باز
 کلیک می‌کنیم. بازکردنسپس پرونده مورد را انتخاب و در نهایت روی دکمه 

برای باز کردن سندیی که اخیرا در رایتر باز شده باشد روش های ساده تری هم هست:

کلیک روی تصویر بند انگشتی سند نظر را در صفحه شروع•

 < از نوار منو و انتخاب سند مورد نظرپرونده < بازکردن نوشتار‌های اخیرانتخاب •

( روی نوار ابزار استاندارد.Open iconکلیک روی مثل کوچک روبه پایین کنارشمایل بازکردن)•

(Switch Windowsتعویض پنجره فعال یا پرونده جاری)
همان طور که می دانید فقط یک پرونده جاری می توانیم داشته باشMMیم یعMMنی همزمMMان نمی تMMوانیم

 توانیم از منMMویمی چندین سند باز نیازمند ویرایش باشد  مشغول نوشتن در چندسند باشیم.اما اگر
در نوارمنو، فهرست پنجره‌های باز را ببنیم و سند مورد نظر خود را انتخMMاب کMMنیم تMMا پنجMMرهپنجره 

فعال ما شود.

بستن سند
برای بستن پرونده جاری یکی از روش های زیر را به کار می بریم:
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 را انتخاب می کنیم.بستناز نوار منو، •

  را می فشاریم.Ctrl+wیا کلید میانبر •

  را می فشاریم.Alt+F4یا کلید میانبر •

  روی نوار عنوان کلیک می کنیم.Xیا روی  دکمه کنترلی  •

 را انتخاب می‌کنیم.بستننوار عنوان کلیک راست می کنیم و از منوی ظاهرشده یا بر روی •

 کMMه میگر تغییرات داده شده را ذخیره نشده باشد، در هنگام بستن پرونده، اخطاری داده می شMMودا
کلیک کنید.ذخیره یا عدم ذخیره یا انصراف از بسته شدن پرونده توانید روی دکمه 
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راهنمای شروع به کار با لیبره آفیس-رایتر

۲فصل 
ویرایش سند



 روش‌های نمایش سند

رایتر سه شیوه کلی برای نمایش و ویرایش یک سند دارد: عادی، وب و تمام صفحه. برای تغییر نما،
از منوی نما روی نمایی که نیاز داریم کلیک می‌کنیم.

نما یا در‌واقع پیش‌نمایش چاپ هم نمای دیگری است که البته غیرقابل ویرایش است که می‌تMMوانیم
( فعال کنیم.File > Print Preview)آن را از پرونده < پیش‌نمایش چاپ

(Normal viewنمای عادی)
نمای عادی، نمای پیش‌فرض رایتر است که سند را همان طور که قرار است چاپ یا پی دی اف شود

نشان می‌دهد.

می‌توانیم سرصفحه و پاورقی و سایر فضMMاهای خMMالی بین صMMفحات رادر نمای عادی در صورت نیاز 
از نوار منو برداشته  Show Whitespace نما <  مخفی کنیم؛ برای این کار علامت انتخاب از

شود.

نکته

Single-pageنمای تک صفحه ای)  ViewدازهMMه انMMه بMMا توجMMچند صفحه ای ب ،)
Multiple-pageصفحه نمایش و بزرگنمMMایی فضMMای کMMاری )  View(ابیMMو کت )

Book Viewه رویMMمایل مربوطMMهم نماهای عادی هستند که با کلیک روی ش )
نوار وضعیت در کنار ابزار بزرگنمایی قابل استفاده هستند.

نمای وب
 آن را در مرورگر اینترنتی در حال مشاهده هستیم. گویانمای وب سند را آن طور نشان می دهد که 
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نمای تمام صفحه
در این نما، نوار ابزارها و نوارجانبی وجود ندارد؛ سند تمام ناحیMMه را پMMر می کنMMدو البتMMه  بMMر اسMMاس

تمMMام صMMفحه ازبزرگنمایی  و چیدمانی که در نمای عادی انتخاب شده بMMود. بMMرای رفتن بMMه نمMMای 
  کلیMMدیا برای خروج از این نما هم می توانیم می کنیم و  استفاده  Ctrl+Shift+Jکلیدهای‌ میانبر 

Esc.را بفشاریم یا کلیدها را یک بار دیگر بفشاریم  

انتخاب کردن متن

برای انجام کارهای ویرایشی بر روی متن، لازم است ابتدا متن مورد نظر را با موشی یا صMMفحه کلیMMد
انتخاب کنیم.

انتخاب متن

(قسمتی از متن برای ویرایش، قالب‌بندیHighlight کردن)رجسته یا درخشانبه ب
یا رونوشت گرفتن و … از آن، انتخاب کردن متن می‌گوییم.

(paragraphبند)

‌ از هم جدانشده اند، بند می‌گوییم.Enterبه عبارات یا جملات پشت سر هم که با 
به عبارت ساده با نقطه سرخط یک بند به پایان می رسد.

 انتخاب متن در رایتر شبیه انتخاب متن در دیگر برنامه های کMMاربردی اسMMت. می تMMوانیم نشMMانگر
 مورد نظر ببریم و چندبار کلیک کنیم برای انتخاب یک کلمه)دوبار کلیک(، یMMکمتنموشی را روی 

جمله)سه بار کلیک( و یک بند)چهاربار کلیک(.

 و هم استفاده کنید.ctrl و shiftباز هم شبیه انتخاب در برنامه‌های دیگر می‌توانیم از کلیدهای 

جMMایی  را نگهداشته ایم به کمک کلیدهای جهتی)بالا-پایین-چپ-راست( یا اگMMر shift وقتی دکمه 
همچMMنین مMMادیگری از متن کلیک کنیم فاصله بین کلیک جدید و محMMل قبلی انتخMMاب خواهدشMMد.

افزایش استفاده کنیم تا با کلیک محدوده انتخاب را shift به جای نگه داشتن f8می‌توانیم از کلیک 
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Extended  حالت انتخاب در‌واقع به حالت انتخMاب افزایشMی)f8دهیم. با   selectionدیلMتب)
 دوباره، حالت انتخاب را به حالت استاندارد انتخاب بر می گرداند.f8می‌شود و 

 را۸یک راه برای تغییر حالت‌های انتخاب استفاده از شمایل مربوطه در نوار وضعیت اسMMت.)شMMکل 
ببینید(. موقعی کMه روی آن کلیMک راسMت کMنیم منMویی بMاز می‌شMود کMه گزینه‌هMای مختلفی در

 ‌عمMMلshift کMMه مشMMابه  f8دسترسمان قرار می دهد.انتخاب استاندارد، انتخMMاب افزایشMMی)کلیMMد 
( و انتخMاب بلMوکی) عم@@ل می کندctrl مش@ابه نگ@@ه داش@@تن Shift+F8می‌کرد، انتخMاب اضMافه)

Ctrl+Shift+F8که  به ما امکان انتخاب متن  چند نویسه یا کلمه از ابتدا، میانه ی@@ا انته@@ای چن@@د 
خط می دهد(

غیر پیوسته قسمت‌هاانتخاب 
 پس از انتخاب اولین قطعه متن به کمک موشی،۹برای انتخاب قسمت‌های غیرپیوسته شبیه شکل 

Ctrl را پایین نگه می‌داریم و  قطعه متنی دیگر را انتخاب می کنیم. به جای نگMMه داشMMتن ctrlدکمه 

م تا چند متن را بتوانیم همزمان انتخاب کنیم. استفاده کنی‌Shift+F8هم می‌توانیم از  
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Addnig حالت انتخاب کردن از استاندارد به حالت انتخاب اضMMافه)Shift+F8با    Selection)
تغییر خواهد کرد و فشردن مجدد آن انتخاب را به حالت استاندارد برمی‌گرداند.

انتخاب بلوک عمودی متن
از حالت انتخابی بلوکی رایتر می توانیم بلوکی از متن ها را از چند چند سطر انتخاب کنیم. بMMرای این

selectionوایریش < کار می توانیم از منوی   modeمارهMMشکل ش(د۸ یا نوار وضعیتMMا کلیMMی  )
  وshift، با کمک موشMMی یMMا ۱۰ حالت بلوکی را انتخاب کنید و شبیه شکل ctrl+shift+f8ترکیبی 

دکمه های جهتی صفحه کلید بلوکی از  متن را انتخاب کنید.
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 متنسباندنبرش، رونوشت و چ
بریدن و رونوشت متن در رایتر شبیه برش و رونوشت متن در برنامه های دیگر است. مMMا می‌تMMوانیم
متن انتخاب شده ای را با کشیدن با موشی، کلیک راست، شمایل مربوطMMه یMMا کلیMMدهای میMMانبر  در
داخل سند یا بین اسناد رونوشت یا جابجا کنیم. همچنین می توانیم از دیگر منابع مثل صفحات وب

متنی را رونوشت بگیریم و آن را در سند رایتر بچسبانیم.

 جدید بکشید و رها کنید.محل موشی استفاده کنید و آن را به از )کشیدن و رها کردن(ابجایی متن انتخاب شدهبرای ج•

 نگهدارید.هم را در Ctrlبرای رونوشت متن انتخاب شده، ضمن کشیدن، کلید •

 را  برای بریدن متن استفاده می‌کنیمCtrl+X)بریدن و جایگذاری در محل جدید(، برای جابجایی متن انتخاب شده•
 متنچسwwباندن بwwرای Ctrl+Vو سپس مکان نما را در نقطه‌ای که قرار است جای‌گذاری کwwنیم قwwرار می دهیم  و از 

استفاده کنید. روش دیگر استفاده از دکمه‌های نوارابزار است.

( استفاده می‌کنیم قالب و سMMبک مبMMدا)مثلا نMMوع و انMMدازهpasteوقتی به طور معمول از چسباندن)
قلم( هم حفظ می‌شود.
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می دهیم( را بMهبرای اینکه متن جابجا شده، قالب‌بندی و سبک متن مقصد)جایی که در آن‌جMا قMMرار 
:خود بگیرد

 را انتخاب می‌کنیم یاPaste Specialاز ویرایش <  •

 نوار ابزار  کلیک می کنیم یا( Paste Iconچسباندن) مثلث کوچک کنارروی •

 تازیرمنوها دیده شود یا می‌داریمکلیک موشی را نگه  چسباندن، از نوار ابزار روی شمایل•

•Ctrl+Shift+V.را می زنیم  

.می‌کنیم( را از منو نتایج انتخاب Unformatted text )بدون قالب متن سپس

نکته

بچسبانیم.  Ctrl+Alt+Shift+Vمی‌توانیم متن را بدون قالب مبدا، در مقصد با زدن  

جستجو و جایگزینی متن

 برای اولین روش بMMرای جسMتجو اسMتفاده از نMوارابزار برای جستجوی متن در سند دو راه دارد:رایتر
 است. Find & Replace( است و روش دیگر استفاده از پنجره محاوره‌ای Find)جستجو

جستجو استفاده از نوارابزار 
پنجMMره برنامه مشاهده می‌شود، پایین ۱۱به طور پیش‌فرض نوارابزار جستجو، همان طور که در شکل

 توضMMیح داده شMد امکMان۱)درست بالای نوار وضعیت( مشMاهده می‌شMMود؛ همMانطور کMه در فصل
اگر این نوار ابزار را نمی‌بینید نگMMران نباشMMید می‌تMMوان آن را از. وجودداردجابجایی و شناور کردن آن 

 ظاهرکرد.Ctrl+F  یا (View > Toolbars > Findنما < نوارابزارها < جستجو )منوی 
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 بMMزنیم. ازEnter ورودی بنویسMMیم و کMMادر افیسMMت آن را در ، ک متن یا عبارت متنیبرای جستجو
 نیز می توانیم آن را اگر در موقعیتFind Previous یا Find Nextهای بالا و پایین ‌طریق دکمه

( نشان می دهد.Highlight هم همه یافته ها را برجسته)Find Allهای قبلی یا بعدی پیدا کنیم. 

خفی کردن این نوار ابزار  چندین راه دارد از جمله:م

 ابتدای نوار ابزارX دکمهکلیک روی •

 در زمانی که در کادر جستجو قرار داریمEscزدن •

 Find & Replaceاستفاده از پنجره محاوره‌ای  

( از روش های زیر اقدام می کنیم:۱۲شکل   )Find & Replaceبرای نمایش کادر محاوره‌ای 

 Ctrl+Hکلیدهای میانبر •

.می‌کنیمرا از از نوارمنو انتخاب  Edit > Find & Replace ویرایش <...•

 روی نوارابزار جستجو Find & Replaceکلیک روی دکمه  •
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Otherهنگام باز بودن این کادر محاوره ای روی این اختیار را داریم که   OptionsاMMکلیک کنیم ی 
(را ببینید ۱۲شکل ). امکانات جستجو را گسترش دهیم

برای استفاده از کارد محاوره‌ای جستجو و جایگزینی به ترتیب زیر عمل می کنیم:

 می نویسیمFindمتنی که می‌خواهیم جستجو کنیم را در کادر (1

 می‌نویسیمReplaceبرای جایگزینی آن متن با متنی دیگر، متن جدید را در کادر (2

)match case. مانند می‌کنیم گزینه‌های مختلفی را انتخاب ر صورت نیازد(3  بزرگی یwwا کwwوچکی حwwروفتطابق با 
 کل کلمات یعنی متن مورد جستجو جزیی از یک کلمه نباشد مثلافقط )whole words onlyانگلیسی( یا  

اگر دنبال کلمه »دانش آمwوز«  هسwتیم دانش آمwwوز در کلمwwاتی ماننwwد»دانش آمwwوزان«، »دانش آموزهwwا« یwwافت نشwwود(.
: جستجو فقwwط در متن انتخwwاب شwwده، جسwwتجو از مwwوقعیت فعلیمثلهمچنین گزینه‌های دیگر هم  در دسترس است 

. سندمکان نما به عقب به سمت ابتدای 

یادداشت

در مثال جستجوی »دانش آموز« فقط در کلمات کامل، اگر »دانش آموزها« با فاصله
بین دانش آموز و ها به صورت »دانش آموز ها« نوشته شده باشد کلمMMه دانش آمMMوز

کلمه کامل و جدا از کلمه بعدی به نظر خواهد رسید و در نتایج خواهد آمد.

داده خواهدشwwد و در نمwwایش اگر نتیجه ای یافت شwwود بwwه صwwورت برجسwwته، می‌کنیم کلیک Find Next بر روی (4
 متن جدید جایگزین کنید.Replace با کلیک کردن بر روی صورت نیاز به جایگزینی

نکته

Replaceاز نیاز به مشاهده موردی نتایج نداریم با کلیک روی    AllاMMهمه نتایج ب 
متن موردنظرمان جایگزین خواهد شد.

هشدار

 باید با احتیاط و دقت و اطمینان استفاده کنیم چراکه اگر سند راReplace Allاز  
ذخیره  و بسته شود؛ دیگر قابل بازگشت به حالت قبل نخواهدبود.
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درج نویسه‌های ویژه

 ¢M¾ M© æ ç Ł ñ ö ø نویسه‌های ویژه مواردی است که در صفحه کلید پیدایشان نمی کنیم مثلا
. همگی نویسه‌های ویژه هستند

برای درج یک یا چند نویسه ویژه، نشانگر را در موقعیتی که می خواهیم نویسه ها ظاهر شMMوند قMMرار
می‌دهیم و به یکی از روش های زیر اقدام می کنیم:

Special نویسه ویژه)روی شمایل•  Character )تی ازwwنیم تافهرسwwک می کwwتاندارد کلیwwروی نوارابزار اس 
را۱۳نویسه های برگزیده یا اخرا استفاده شده باز شود و برای درج، روی هر کدام که خواستیم کلیک می کنیم) شwwکل 

 کwwادرMore Characters(.همچنین می توانیم در انتهwwای فهرسwwت بازشwwده،  بwwا کلیwwک روی دکمwwه  ببینید
( را بازکنیم.۱۴محاوره‌ای نویسه‌های ویژه)شکل

Insert درج < ... کلیwwک روی منwwوی•  > Special  Character  دنwwاز  شwwرای بwwاوره‌ای بwwادر محwwک
( و سپس دوبار کلیک روی نویسه‌هایی ]از هر قلم یا ترکیبی از قلم‌هwwا[ کwwه  می‌خwwواهیم درج۱۴نویسه‌های ویژه)شکل

شود. نویسه‌هایی که انتخاب کردیم در سند درج می‌شود و همچنین به فهرست نویسه‌های اخیرا استفاده شwwده اضwwافه
می‌شوند.

 نویسه های ویژه مختلف هستند. اگر نویسه ویژه به خصوصی را پیدا نکردیمشاملقلم‌های مختلف 
را باید امتحان کنیم.لازم است قلم های دیگر 

37 | درج نویسه‌های ویژه

: درج نویسه ویژه از نوارابزار استاندارد۱۳شکل 



نکته

 برای مشاهده جزییات نویسه یک‌بار روی آن کلیک می کنیم تا جزییات آن از جمله
کدعددی آن مشاهده شود.

با دوبار کلیک روی نویسه مد نظر، نویسه مدنظر درج می شMMود و کMMادر محMMاوره‌ای
نویسه های ویژه همچنان باز می‌ماند. اما اگر روی نویسه مدنظر ]یMMک بMMار[ کلیMMک

 را بزنیم؛ نویسه درج و پنجره بسته می شود.Insertکنیم و سپس دکمه 
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راهنمای شروع به کار با لیبره آفیس-رایتر

۳فصل 
قالب‌بندی



مقدمه

وقتی یک متن ساده را در رایتر می نویسیم ممکن است از لحاظ ظاهری زیبMMا بMMه نظMMر نرسMMد و لازم
است به کمک قالب‌بندی، ظاهر متن را به گونه‌ای تغییر دهیم تا زییایی و خوانایی مورد نیاز را داشته

باشد. این فصل، اصول قالب بندی متن در رایتر را پوشش می‌دهد، مفاهیمی از قبیل:

قالب‌بندی بندها و نویسه‌ها•

قالب‌بندی دستی و سبک‌ها•

استفاده از قالب‌بندی خودکار•

ایجاد فهرست‌های گلوله‌ای، شماره دار یا طرحواره ای•

 توضMMیح داده شMMده اسMMت،۲در این فصل فرض بر این است که با تکنیک‌هMMای متMMنی کMMه در فصل
آشنایی داریم.

قالب‌بندی نویسه‌ها

ما می‌توانیم بعد از انتخاب متن)نویسه های( مورد نظر، قالب‌های متعMMددی بMMه آن  اعمMMال کMMنیم.
مهم‌ترین ابزار‌های قالب‌بندی نویسه ها از طریق دکمه‌های نوارابزار قالب بندی  و با استفاده از پانMMل

نویسه ها در دسته خصوصیات نوار جانبی در دسترس هستند از جمله:

( و اندازه و جلوه‌های آنFont قلم)نوع•

(، زیرخط دار و…(Italic(، کج)Boldسبک نگارش قلم )توپر)•

رنگ قلم و پس‌زمینه آن•

نوع قلم، اندازه و جلوه‌ها
 را از راه های زیر می‌توانیم تغییر دهیم:نوع، اندازه، رنگ و جلوه ها و سایر ویژگی‌های قلم

 نوارابزار قالب بندیفهرست‌های کشویی قلم و اندازه و سایر دکمه‌های دراز  •

با استفاده از پانل نویسه ها در دسته خصوصیات نوار جانبی •
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پنجره محاوره‌ای قلم•

 قلم غیر از کشوی فهرست اندازه قلم روی نMMوارابزار قالب‌بنMMدی، راه افزایش یا کاهش اندازهبرای
دکمه افMMزایش و کMMاهش انMMدازه قلم کلیMMکدیگری نیز وجود دارد؛ می توانید از پانل نویسه ها روی 

( تغییر می دهد.Point نقطه)۲کنید که معمولا اندازه قلم را 

(Pointنقطه)

 اینچ۱/۷۲هر نقطه برابر است با 

تنظیمات روی محاوره‌ نویسه
( دارد.کMMه در این بخش نشMMان دادهtab( شMMش صMMفحک)زبانMMه یاcharacter نویسMMه)محMMاوره

می‌شود.برای باز کردن محاوره نویسه چندین راه وجود دارد:

 از روی نوار منو  Format > character قالب بندی < ... کلیک روی منوی•

character  از زیرمنوی characterکلیک راست روی متن انتخابی و انتخاب  ... •

 بازاست.Properties  نوار جانب، وقتی دسته Character پانل More Optionsکلیک روی چرخنده •

قلم، انداز، رنگ و جلوه‌های قلم
ج(، عMMادی، تMMوپر، کشامل قلم، سبک)حالت های مختلف قلم نام( می‌توانیم ۱۵)شکل قلم زبانهدر 

 آن را مشخص کنیم.اندازه و زبان

‌ موارد مربوطCTL Font موارد مربوط به زبان لاتین و از قسمت western Text Fontقسمت 
به زبان فارسی را تنظیم می‌کنیم.

( نیز می‌توانیم رنگ قلم و طیفی از جلوه‌ها را انتخاب کMMنیم کMMه البتMMه۱۶)شکل جلوه‌های قلماز زبانه
برای مستندات رسمی چندان مناسب نیستند.
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موقعیت
در زبانه موقعیت می توانیم موقعیت نویسه ها را مشخص کنیم به این معنا که:۱۷مطابق با شکل 
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 اندیس هستند چند درصد اندازه قلم اصلی باشند.گر و اپایین  یا اندیس بالا یا اندیس باشندعادی •

 درجه باشند یا به عبارت دیگر عمودی باشند یا افقی) ۲۷۰ یا ۹۰، ۰دارای زاویه •

دی
(عمو

فاصله بین نویسه های وجود داشته باشد•

(HyperLinkفراپیویند)
 کلیMMکبازبانه فراپیوند این امکان را با ما می دهد نشانی اینترنتی یا پرونده ای را مشخص کMMنیم تMMا 

آن پرونده یا صفحه اینترنتی باز شود.روی نویسه‌های انتخاب شده،  

(HighLight)سازیبرجسته 
زبان برجسته کردن می توانیم شبیه ماژیک های فسفری، نویسه‌های مدنظرمان را با رنگی دلخواه،از 

برجسته کنیم، همان طور که قبلا هم گفته شد، انجام این کار از نوارابزار قالب‌بندی و نوار جMMانبی هم
امکان‌پذیر است)دکمه کنار رنگ قلم(
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حاشیه‌ها
آخرین زبانه هم برای این که دور نویسه های خود به ترتیبی که مMMدنظر داریم، حاشMMیه‌ای بMMا جلMMوه

مدنظر خودمان اضافه کنیم. در مورد حاشیه ها در قسمت بندها توضیح بیشتر ارائه خواهد شد. 

قالب بندی بندها

برای قالب‌بندی بند نیاز به انتخاب بند نیست و تنها کافیست مکان نما در بند باشد. البته اگر چند
بند را بخواهیم همزمان قالب‌بندی کنیم باز هم لازم است ابتدا حداقل بخشMی از هMر دو را انتخMاب

 می‌توانیم قالب‌های مختلفی را به بندها اعمال کنیم، مثلا با استفاده از:کرده باشیم.ما

شمایل روی نوار ابزار قالب‌بندی•

  نوار جانبیProperties از دسته Paragraphپانل •

 منوی قالب‌بندی نوار منودردستورات موجود •

گزینه‌های موجود در محاوره بند•

 دربند از طریق دکمه‌های نوارابزار قالب بندی  و با استفاده از پانل بندمهم‌ترین ابزار‌های قالب‌بندی 
دسته خصوصیات نوار جانبی در دسترس هستند.

 دکمه‌ها و شمایل مربوط به بند معرفی شده اند.۱۸در زیر شکل

ترازبندی بند
ترازبندی یا چینش که در اینجا منظور تراز بودن خطوط مد نظر است را با مثال توضیح خواهیم داد.

وقتی می گوییم این بند راست چنین است یا از راست تراز شده است منظور این است که فاصله همه
اولین کلمات آن بند از حاشیه سمت راست یکسان است.

که مشابه آن در نوار قالب‌بنMMدی وجMMود دارد بMMرای ترازبنMMدی۱۸ شکل ۴ تا ۱ما می توانیم از دکمه 
استفاده کنیم.شکل نمونه‌های از اعمال ترازبندی به متن را به شما نمایش می‌دهد.
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تورفتگی از چپ15افزاش فاصله با بند بعدی و قبلی8چپ چین)تراز چپ(1

تورفتگی از راست16کاهش فاصله با بند بعدی و قبلی9وسط چین2

تورفتگی اولین خط17افزایش تورفتگی10راست چین3

فاصله خطوط18کاهش تورفتگی11تراز از دو طرف4

گزینه‌های بیشتر از طریق باز شدن12Hanging Indent19گلوله‌ها5
محاوره مربوطه فاصله قبل از بند13شماره‌گذاری6

فاصله بعد از بند14رنگ پس زمینه7

: پانل های سبک و بند از دسته خصوصیات روی نوار جانبی۱۸شکل 

متن راست چین یا از ترازشده از راست.
متن وسط چین

متن چپ چین یا ترازشده از چپ
(بین کلمات هر خط در صورتی که کل خط را پرنکنند، فاصله‌هایی درج می کند یاJustifiedمتن هم‌تراز شده)

در فارسی برخی کلمات کشیـــده تر می کند تا فاصله ابتدای اولین کلمه از حاشMMیه راسMMت و آخMMرین کلمMMه از
حاشیه چپ، در خطوط ماقبل آخر یکسان باشد.

: گزینه‌های ترازبندی متن۱۹شکل 
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یادداشت

خط اول و آخر هر بند گاهی در ترازبندی استثنا می‌شMMوند. بMMه عبMMارتی گMMاهی بMMرای
زیبایی متن خط اول هر بند را تورفته می‌کنیم و خط آخر بMMرای این کMMه ممکن اسMMت

نیاز به فاصله و کشیدگی زیاد داشته باشد هم‌تراز با سایر خطوط نمی‌شود.

تنظیم فاصله بین خطوط و بندها
 مشMMاهده می شMMود، همMMان طMMور کMMه از نMMام آن۱۸ شکل ۱۸فاصله بین خطوط که در دکمه شماره 

پیداست فاصله بین خط زمینه دو خط است.

( است؛ بدیهی است با بیشتر کMMردن این مقMMدار،single)۱به طور پیش فرض فاصله خطوط از هم 
فاصله خطوط از هم بیشتر و بالتبع تعداد خط در یک صفحه کم‌تر خواهد شد. مثلا اگر این فاصله را

.شده است)دوبرابر( قراردهیم انگار یک خط در میان نوشته ۲

 دیده۱۸فاصله بند اشاره دارد به فاصله عمودی بند با بند قبلی و بعدی، که همان طور که در شکل 
 قابل تنظیم است.البته اگر بخواهیم فاصله بند از بند قبلی متفاوت۹ و ۸می‌شود از طریق دکمه‌های 

 نشMMان۱۴ و ۱۳ با شماره ۱۸از فاصله آن با بند بعدی باشد؛ مقدار مورد نظر را  قسمتی که در شکل 
داده شده، ثبت می‌کنیم.

تورفتگی
برای تورفتگی یا کنگره ای کردن متن در جهت زیبایی و خوانایی بیشتر متن، می‌توانیم از دکمه هMMایی

 بین حاشMMیه صMMفحه و خطMMوط بنMMد رافاصله خورده است، مقدار ۱۱ و ۱۰ برچسب ۱۸که در شکل 
افزایش و در صورت نیاز دوباره کاهش دهیم.

 در همان شکل نیز می توانیم فاصله حاشیه از ابتدا یا۱۶ و ۱۵از تنظیمات مشخص شده با برچسب 
 هم مشخص کننده تنظیمات تورفتگی صرفا بMMرای۱۷انتهای خطوط را نیز مشخص کنیم. برچسب 

اولین خط است.
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 را تغییر می دهد؛ بدین معنا که به جای تورفتگی خMMط اول، سMایرتو رفتگی خط اول کارایی ۱۲دکمه  
خطوط غیر از خط اول شامل افزایش یا کاهش تورفتگی خواهندشد.

این بند نمونه‌ای است از تورفتگی خط اول بند است کMMه در بنMMدهای کتاب‌هMMا معمMMول
است. در بند بعدی نمونه ای از حالت برعکس آن خواهید دید.

hangingاین بند هم نمونه‌ای اسMMت از بنMMد بMMا تMMورفتگی همMMه خطMMوط غMMیر از خMMط اول)

indentتورفتگی غیر خط اول اغلب برای شماره گذاری بندها، یا قرار دادن شمایل یا .)
تصویری در ابتدای خط اول استفاده می‌شود تا شماره یا تصویر موجب تورفتگی ظMMاهری

خط اول نشود

رنگ پس‌زمینه بند
 نشMMان۷ چسب  با بر۱۸شکل پس‌زمینه بند رنگی باشد می توانیم روی دکمه‌ای که در برای این که 

داده شده، کلیک می‌کنیم تا جعبه رنگ باز شود، یک رنگ انتخاب کنیم. اگر رنگ مورد نظرمMMان در
 رنگی سفارشی و دلخواه انتخاب می‌کنیم.رنگ‌هایی که اخیراCustom Colorجعبه رنگی نبود از  

 مشاهده می‌شود.Recentدر این قسمت یا سایر قسمت‌های برنامه استفاده شده است، در قسمت 
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نکته

, مانند این کتاب مورد استفاده قMMراررایانه‌ایفاصله‌گذاری بند اغلب در مستندسازی 
 معمولًا در سایر اسناد مورد استفاده قرار می‌گیرد. برای طراحیتورفتگی بندمی‌گیرد. 

 از فاصله بند یا تو رفتگی استفاده کنید اما هرگز هر دو با هم استفاده نکنید.،خوب

تنظیمات روی محاورهٔ بند
  کMMه درصMMفحه پMMرش هMMاTabs بند شامل چندین زبانMMه اسMMت: پرش‌هMMا)

(، نویسه های بزرگ سMMربند)Bordersتوضیح آن آمده است.(، حاشیه‌ها)
drop  caps(هMMناحی ،)دMMابه همین بنMMد مشMMبرای بزرگ نویسی اولین حرف یا کلمه بن AreaهMMک 

انتخاب‌های بیشتری غیر از رنگ برای پس زمینه بند فراهم می کند(، گلوله و شماره‌گذاری.

محاورهٔ
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تورفتگی‌ها و فاصله‌گذاری
انبیمشابه تنظیماتی که از نوار‌ابزار قالب‌بنMMدی و نوارجMM مشاهده می شود ۲۱همان طور که در شکل 

در اختیار داشتیم در این محاوره نیز در اختیارمان است و البته این مزیت در این محاوره وجMMود دارد
که می توانیم قبل از اعمال، پیش‌نمایشی شماتیک را مشاهده کنیم.

(Alignmentترازبندی)
 ردیف کردن دیده می شود نیز تنظیماتی مشMاهده۲۲در مورد ترازبندی متن که ترجمه آن در شکل 

می شود که در نوارابزار قالب‌بندی و نوارجانبی مشاهده کرده بودید.

این محاوره علاوه بر مزیت گفته شده در سربرگ قبلی)مشاهده پیش نمایش( ، این مزیت را دارد که
می توانیم برای خط آخر در تراز دو طرفه هم تعیین تکلیف کنیم. مثلا بخMMواهیم آخMMرین خMMط بنMMد،
وسMMMMط‌چین باشMMMMد یMMMMا آن هم ماننMMMMد این بنMMMMد، اجبMMMMاراً از دو طMMMMرف تMMMMراز باشMMMMد.
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(Stylesقالب‌بندی: مستقیم)دستی( یا سبک‌ها)
دو گونه قالب بندی داریم که در ادامه توضیح داده خواهدشد.

 قالب‌بندی مستقیم]یا دستی[ 
اعمال قالب‌بنMMدی بMMه طMMور مسMMتتقیم روی بنMMدهای خMاص، نویسMMه‌ها، صMMفحات،قاب‌هMMا،
فهرست‌ها یا جداول. به عنوان مثال می‌توانیم کلمه ای را انتخاب کنیم و سپس روی دکمه‌ای

 کنیم.( کلیکItalic(یا کج)Bold)از نوار قالب‌بندی، مانند توپر

سبک‌ها
ه‌ای از گزینه‌های قالب‌بنMMدی تحت عنMMوان یMMک نMMام. بMMه عنMMوان مثMMال، سMMبک بنMMد)بست

paragraph  styleله بینMMدازه آن، فاصMMد قلم، انMMمی تواند شامل تنظیمات معتددی مانن)
فاده کنیم با انتساب آن سبک بMMه بنMMدخطوط و غیره باشد که هرجای که خواستیم از آن است

خاص، همه تنظیمات یک جا اعمال می شود.

استفاده از سبک‌ها توصیه می‌شود
 از آنجا که سبک‌ها مجموعه ای از قالب‌ها را، همزمان اعمال می‌کند،‌ به ما این توانایی را می‌دهد کMMه
قالب یک سند را منظم کنیم و با کم‌ترین زحمت، قالب‌بندی را در تمام سند اعمال کMMنیم. بنMMابراین
استفاده از سبک‌ها به شدت توصیه می‌شود. به علاوه این که استفاده از سبک‌ها قابلیت هایی ماننMMد

فراهم می کند که ممکن است از آن مطلع نباشید.ایجاد خودکار فهرست مطالب را 

 صفحه‌ای را با نرم‌افMMزار رایMMتر تMMایپ و صMMفحه آرایی۲۰۰فرض کنید که می‌خواهیم یک کتاب مثلا 
کنیم؛ اگر به صورت معمولی از نرم افزار استفاده کنیم، بعد از تایپ کتاب اگر از ما خواسته شود قلم
یا رنگ بندی عناوین کتاب را تغییر دهیم، نیاز به صرف زمان زیادی دارد. یا اگر بخواهیم فهرسMMتی
از مطالب کتاب به همراه شماره صفحه آن استخراج کنیم، کار طاقت فرسایی است به ویMMژه اگMMر بMMا

تغییر اندازه قلم ها یا اندازه صفحه و...، شماره صفحات تغییر کند.

( استفاده کرده باشیم همه این کار ها)به‌روزرسانی‌ها( با یک دستور بهStyleاما اگر از قابلیت سبک‌)
( یا  چند کلیک ساده انجام می شود.updateروز رسانی)
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اعمال سبک‌ها به طور آسان و سریع از دسته سبک‌ها در نوار جانبی امکان‌پذیر است.

احتیاط

 قالب‌بندی دستی ] که قالب بنMMدی مسMMتقیم هم خوانMMده می‌شMMود[، سMMبک‌ها را رد
ویت اعمال بالاتری دارد، به این معنا که اگر قسمتی را به طورمی‌کند یا به عبارتی اول

دستی قالب بندی کنیم، هیچ سبکی بر آن قسمت، اعمال نمی‌شود.

حذف قالب‌بندی دستی
برای حذف قالب‌بندی دستی، متن مورد نظر را انتخاب می کنیم و:

 را انتخاب می‌کنیم یاFormat > Clear Direct Formatting  قالب‌بندی < از نوار منو •

 را انتخاب می کنیم یاClear Direct Formattingروی آن کلیک راست می‌کنیم و  •

 روی نوار ابزار قالب بندی، کلیک می‌کنیم یاClear Direct Formatting شمایل  روییا •

•Ctrl+M.را از صفحه کلید می‌فشاریم 
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راهنمای شروع به کار با لیبره آفیس-رایتر

۴فصل 
کار با جدول

تقدیم به پدر عزیزم که  آسمانی شد



مقدمه

جداول راه مفیدو کاربردی برای سازماندهی و ارائه مقادیر زیادی از اطلاعات هستند، مثل:

گزارش‌های فنی،  مالی یا آماری•

صوصیات و تصاویر محصولاتکاتالوگ توضیحات، قیمت ها، خ•

 صورت‌حساب ها و فاکتورها•

فهرست اسامی با نشانی، سن، حرفه و دیگر اطلاعات•

جدول‌ها می‌توانند بیشتر به عنوان جایگزینی برای صفحات گسترده به منظور سازماندهی اطلاعMMات
استفاده شوند. یک جدول خوب طراحی شده می تواند خوانندگان را کمک کند تا بهتر متوجه شMMوند

 که به طMMور معمMMول بMMرای متن یMMا اعMMداد از جMMدول اسMMتفادهر مواقعیکه چه می‌خواهیم بگوییم. د
می‌کنیم،  می‌توانیم دیگر اشیاء از قبیل تصاویر را هم در سلول های جدول قراردهیم.
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ابزارهای کار با جداول

 ( و۲۳ در نMMوار منMMو)شMMکل Tableهمه دستورات جدول شرح داده در این فصل به راحتی از منوی 
 ( دیده می‌شود.۲۴نوارابزار جدول)مشابه  شکل

موقعی که جدولی ایجاد می‌کنیم یا جدول موجودی را انتخاب می‌کMMنیم، نMوار ابMMزار جMدول )مشMابه
 ( به طور خودکار ظاهر می‌شود. البته می توانیم هر زمانی که خواستیم آن را بMMا کلیMMک روی۲۴شکل

ظاهر کنیم.( View > Toolbars > Tableنما < نوارابزارها < جدول )

 سطربالای سطر خالی ایجاد1
انتخابی

رنگ پس‌زمینه سلول جدول17

سبک‌های قالب بندی خودکار18ایجاد سطر خالی پایین سطر انتخابی2
 خالی قبل سطرستون ایجاد3

انتخابی
حاشیه‌ها19

سبک حاشیه20ایجاد ستون خالی بعد از سطر انتخابی4
رنگ حاشیه21حذف سطرهای انتخابی5
قالب‌بندی عددی:ارزی۲۲حذف ستون‌های انتخابی6
قالب‌بندی عددی: درصد23حذف جدول7
قالب‌بندی عددی:اعشاری24انتخاب سلول8
قالب عددی25انتخاب جدول9
درج شرح26ادغام سلول‌ها10
مرتب‌سازی27تفکیک سلول‌ها 11

محافظت از تغییر مقدار سلول‌ها28 جدولتفکیک12
حذف محافظت از تغییر مقدار سلول‌ها29بهینه‌سازی اندازه13
مجموع30تراز از بالا14

کار با جدول۴فصل  | 54

شکل
۲۴:

نوارابزار
جدول



فرمول نویسی31وسط عمودی15
مشخصات جدول32تراز از پایین16

 را هم در منوی راست کلیک روی جدول یا پانل جدول دسMMته خصوصMMیاتبزارهای جدولبرخی از ا
 (۲۵نوار کناری می‌توانیم بیابیم)شکل 

ایجاد یک جدول

نتیجه که می خواهیم کمکقبل از ایجاد جدول در یک سند، رایتربه ما برای داشتن ایده ای از ظاهر 
می‌کند تا برآوردی از  تعداد سطرها و ستون مورد نیاز داشته باشیم. همه مقادیر بعد از ایجMMاد قابMMل
تغییر هستند؛ هر چند از پیش فکر کردن می تواندصرفه زمانی داشMMته باشMMد چراکMMه تغیMMیرات کلی

قالب‌بندی جداول اغلب زحمت زیادی نیاز دارد.

ایجاد یک جدول جدید
درجبرای ایجاد سرع یک جدول با مشخصات پیش فرض، روی شMMمایل 

Insertجدول)  Table ..)نیم.ازMک می‌کMتاندارد کلیMزار اسMروی نوار اب
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 ستونی و پMMانزده سMMطری[ انتخMMاب و کلیMMک میده جدولی که باز می‌شود اندازه جدول را]حداکثر  
کنیم.

برای ایجاد جدول جدید با ویژگی‌های خاص)تعداد سطر و ستون بیشMMتر و…( نشMMانگر را جMMایی کMMه
می‌خواهیم جدول ایجاد شود قرار می دهیم و سپس از یکی‌از راه‌های زیر محMMاوره درج جMMدول را بMMاز

می‌کنیم:

  پایین ایجاد سریع جدولMore Optionکلیک روی دکمه ...•

 از نوار منوTable > Insert Tableانتخاب  •

.Ctrl+F12فشردن  •

 نام، می تMMوانیم نMMامی متفMMاوت از نMMامدر کادر (، ۲۶ محاورهٔ ایجاد جدول )شکل عمومی قسمتدر 
نویسیم؛ این نام در ناوبری یا پیمایش سند یا در واقع سهولت در شناسMMایی و دسترسMMیپیش‌فرض  ب

سریع به جدول مورد نظرمان از  بین جداول موجود، مفید واقع می‌شود.
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تعداد ستون‌ها و سطرهای جدول جدیدمان را مشخص می‌کنیم کMMه Rows و Columnsدر کادر  
البته در صورت لزوم بعدا می توانیم اندازه و سایر مشخصات جدول را تغییر دهیم.

در قسمت گزینه‌ها، مشخصات اولیه جدول را تنظیم می‌کنیم:

•Headingفعال کردن سرستون داشتن که با آن تصریح می‌کنیم که اولین یا چندین سطر اول جدولمان –  
 ستون ها(هستند.)سرشناسه یا عنوانسرستون 

•Repeat heading rows on new pagesسطرهایی که سرستون هستند را  در صفحات — 
 بیش از یک صفحه باشدجدولمانبعدی تکرار می‌کند که بسیار مفید است در مواقعی که 

.Heading rowsدر این قسمت تعداد سطری که سرستون هستند را مشخص می کنیم که به طور طبیعی — 
 است. ۱و پیش فرض مقدار آن برابر 

•Don’t split table over pages.جلوگیری از شکسته شدن جدولی که در صفحه جا نمی‌شود — 
 شود، مفید واقعدیدهاین گزینه می تواند مواقعی که جدول در اواخر صفحه ایجاد شده است و بهتر است کامل و یکجا 

شود به این صورت که اگر ادامه جدول به صفحه بعد  بیفتد،  قسمتی از جدول که در صwwفحه قبwwل بwwوده اسwwت هم بwwه
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صفحه بعد منتقل می شود. بدیهی است که اگر جدول با این که یک صفحه کامل را گرفته و باز هم جwwا نمی‌شwwود چwwه
این گزینه فعال باشد و چه نه ، به ناچار در ادامه شکسته خواهدشد.

می‌زنیم. رایMتر یMک جMدول بMMه(.. Insert درج)بعد از تعیین یا انتخاب موارد مورد نظر روی دکمه
پهنای صفحه با ستون ها و سطر های هم‌اندازه برای ما ایجاد می‌کندو ما می توانیم در ادامه آن هMMا را

در صورت نیاز تنظیم کنیم.

الب‌بندی چیدمان جدولق
قالب‌بندی جدول دو فرآیند دارد؛ یکی قالب بندی چیدمان جدول که موضMMوع همین بخش اسMMت و

دیگری قالب‌بندی متن جدول که موضوع بخش بعدیست.

قالب‌بندی معمولا در برگیرنده یک یا چند علمیات است: تنظیم اندازه و موقعیت جدول در صفحه،
تنظیم اندازه سطرها و ستون‌ها، اضافه یا حذف کردن سطرها یا ستون‌ها، ادغام یMMا تقسMMیم سMMلول‌ها،

تغییر حاشیه‌ها و پس زمینه.

غییر اندازه و موقعیت جدولت
بر اساس تنظیمات پیش ‌فرض، هر جدول جدیدی که ایجاد می‌شود تمام عرض ناحیه متن را اشغال
می‌کند.اما گاهی ترجیح می‌دهیم جدول ماکوچک‌تر باشد. برای تغییر اندازه سریع یک جدول، ابتMMدا
موشی را به کناره‌های چپ یا راست جدول می‌بریم؛ هنگامی که شکل نشانگر به پیکان دوطرفه تغییر
کرد، حاشیه را به موقعیت می‌کشیم.این عملیات فقط اندازه اولین یا آخرین ستون را تغییر می‌دهد و

را ممکن است به هم بزند.  در صفحه جدول)چینش(ترازبندی

وره خصوصیات جMMدول را بMMا انتخMMابابرای کنترل دقیق روی اندازه و موقعیت جدول در صفحه مح
Table Properties یا کلیک راست روی جدول و انتخاب منوی Table > Propertiesمنوی 

 (۲۷می‌کنیم.)شکلباز 
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، می توانیم از طریق راه‌های زیر ترازبندی (۲۷)شکلبرای  ویرایش یک جدول از زبانه جدول محاوره 
جدول را تنظیم کنیم:

تنظیم پیش‌فرض یک جدول، پر کردن عرض ناحیه متنی(:Automaticخودکار)•

 تراز کردن جدول با حاشیه چپ صفحه(:Leftچپ)•

 تراز کردن جدول با حاشیه چپ صفحه(:Rightراست)•

با تعیین دقیق فاصله جدول از سمت چپ صفحه، اجازه می‌دهد (:From Leftاز چپ)•
عرض جدولمان بیشتر از ناحیه متنی صفحه  باشد.و حتی  محل قرارگیری آن  تعیین کنیم

(:تراز کردن جدول  بین حاشیه‌های چپ و راست. به عبارت دیگMMر فاصMMلهCenterوسط)•
جدول از چپ و راست صفحه یکسان خواهدشد.

(: به ما اجازه می دهدفاصMMله از دو سMMمت راسMMت و چپ را در کادرهMMایManualدستی)•
راست  و چپ دقیق و به دلخواه تعیین یا وارد کنیم.
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پهن@@ا)انتخاب گزینه‌ای غیر از خودکار، باعث فعال شدن کMMادر ،@@ (Properties ویژگی‌ها)در قسمت
Width .می‌شود که در آنجا می‌توانیم اندازه جدول مورد نظرمان را وارد کنیم)

Relativeرا هم می توانیم انتخاب کنیم تا به جای اندازه درصدی از پهنای را وارد کنیم 

دایی برای ج(Below(و پایین)above بالای سر )از کادرهای، (Spacingفاصله‌گذاری) در قسمت 
جدول از متن استفاده می‌کنیم.

، رایتر مقادیری راشوددر تغییر اندازه به کمک موشی، هرگاه اندازه جدول کم تر از اندازه ناحیه متنی 
 درج می‌کند.راست و چپدر کادرهای 

تشخیص جریان متن
 (، ما می‌توانیم:۲۸ از محاوره ویژگی‌ها)شکلمتن  جریانزبانهدر 

 صفحه یا ستون قرار دهیم) تا پایان صفحه یا ستون متنی چیزی نوشته نشود(. بwwرایشکنندهقبل یا بعد از جدول، یک •
قبCCل) و گزینwwه هwwای (ColumnسCCتون) یا (Pageصفحه)( با Breakاین کار از ترکیب گزینه شکستن) 

Before) یا (بعدAfter)دولwwواهیم جwwنیم) بخwwاستفاده می کنیم. اگر یک شکننده صفحه، قبل جدول درج ک 
 سبک صفحه جدیدی که جدول به آن منتقل می شود را نیز بwwا انتخwwابخواهیم توانستدر صفحه جدید شروع شود(، 
With Page Styleتغییر دهیم و در ضمن می‌توانیم شماره صفحات را نیز از ابتدا ت  (نظیمreset).کنیم 

 هم می توانیم تاAllow table to split across pages and columnsبا حذف انتخاب   •
نگه داریم؛ کاری کwwه در ایجwwاد جwwدول هم بwwه روش دیگwwری گفتwwهجایی که امکان دارد جدول در یک ستون یا صفحه 

شده بود.

 اجازه نمی دهیمAllow row to break across pages and columnsبا حذف انتخاب  •
این گزینه در حالتی فعال است که گزینه قبلسطر جدول در یک صفحه و بخشی در صفحه دیگر باشد.بخشی از یک 

انتخاب شده باشد.

 برای نگهداشتن جدول به همراه بند بعدی استفاده می‌کنیم تا اگر ازKeep with next paragraphاز •
شکستن صفحه استفاده کردیم  جدول  و بند بعدی در کنار هم بمانند چه در این صفحه ماندنwد چwwه بwwه صwwفحه بعwwدی

منتقل شدند.

 برای تکرار سرستون های جwwدول یعwwنی تعwwداد سwطر اولی کwwه مشwwخص می کwwنیم درRepeat headingاز  •
ابتدای صفحه های بعد استفاده می کنیم تا جداولمان خواناتر باشد.

  برای تعیین جهت متن در سلول استفاده می‌کنیم. جهت‌های قابل انتخاب عبارتنداز:Text orientationاز •
Vertical(، عم��ودی پ��ایین ب��ه ب��الاHorizontalافقی)  (bottom to  top)عم��ودی ب��الا ب��ه پ��ایین ،
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Vertical (top to bottom) (مافوق تنظیمات  از  استفاده  یا   Use superordinate object

settings )یعنی استفاده از تنظیمات پیش فرض جهت متن صفحه

می توانیم چیدمان عمودی متن در سلول‌های انتخاب شده را در ادامه انتخاب کنیم. متن درون یک سلول می تواند از•
  توضیح داده شد مانند سایر متwون از طwرق دیگwرکه در زبانه جدول محاورهبالا، وسط یا پایین تراز شود. چبدمان افقی 

مانند نوار ابزار قالب بندی امکان پذیر است.

تغییر اندازه سطر ها و ستون‌ها
ما می‌توانیم ارتفاع سطر‌ها و پهنای ستون های یک جدول را به چند روش تنظیم کنیم:

موشی را به لبه سلول حرکت می دهیم، وقتی پیکان دو طرفه ظاهر شد، کلیک می‌کنیم و دکمه کلیwwک موشwwی را نگwwه•
می داریم و حاشیه را به موقعیت مورد نظرمان جابجا می کنیم و دکمه ماوس را رها می‌کنیم.

 افقی، ستون‌ها و روی خط‌کش عمودی سطرها، با دو خط نازک خاکستری رنگ علامت‌گwwذاری شwwدهخط‌کشروی •
اند. ما می‌توانیم با موشی اندازه یک سطر یا ستون را با نگه داشتن کلیک روی آن علامت ها و جابجا کردن آن، تغیwwیر

دهیم.
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 از نوار منو نیز گزینه هایی برای تغییر اندازه فراهم می کند:Table > Sizeانتخاب 

برای وارد کردن یک اندازه در(� Row Height  ازتفاع سطر)یا (� Column Widthعرض ستون)  انتخاب •
(برای سطر و ستون‌های انتخابی جدول.Sizeکادر اندازه)

 برای کاهش پهنا یا ارتفاعMinimize Row Height یا Minimize Column Widthگزینه‌های •
سطر و ستون های انتخابی تا حد ممکن است. بدیهی است که با توجه به متفاوت بودن مقدار متن در سطر و ستون

های مختلف،  با این انتخاب اندازه سطر و ستون های مختلف ممکن است با هم یکسان نشوند.

Optimal Row یا ارتفاع بهینه سطر) (Optimal Column Widthگزینه‌های عرض بهینه ستون)•

Height.براساس بیشترین اندازه متن یا عرض و ارتفاع، اندازه ای بهینه تنظیم می ‌کند ،) 

برای  (  Distribute Columns/Rows Evenly )از گزینه‌های توزیع یکنواخت سطرها/ ستون‌ها•
هم‌اندازه کردن سطر یا ستون‌های انتخابی استفاده می‌کنیم.

از محاوره ویژگی‌های جدول Columns بیشتر روی اندازه هر ستون، می توانیم از زبانه کنترلبرای 
( مثلا:۲۹استفاده کنیم.)شکل 

اجازه دهیم پهنای جwدول مطwابق بwا تغیwیرات مwا در صwورتمی توانیم : Adapt table width با انتخاب  •
 این که پهنای کل جدول را تغییر دهیم اندازه ستون ها را تغیwwیرامکان افزایش یا کاهش یابد و اگر انتخاب نشود بدون

اگwردهیم به این معنا که کوچک‌تر کردن یک ستون افزایش همزمان پهنwای سwایر سwتون‌ها را در پی خواهwد داشwت. 
( انتخاب شده باشد این گزینه غیرفعال است.Automaticاندازه جدول خودکار)

   اندازه سایر  ستون ها نwwیز بwwه همwان مقwداری کwwهAdjust columns proportionallyبا انتخاب •
برای یک ستون تغییر می‌دهیم، همزمان تغییر می کند،از آنجا که افزایش و کاهش همزمان ستون ها بwwدون افwwزایش

و کاهش اندازه جدول ممکن نیست؛ با انتخاب این گزینه، گزینه قبل هم به طور خودکار انتخاب می‌شود.

•Remaining spaceمقدار باقی مانده تا حاشیه صفحه را نمایش می دهد که در واقع مقداری است پهنای 
جدول در نتیجه افزایش اندازه ستون ها  قابل افزایش است.این مقدار قابل ویرایش نیست، مقدار منفی هم نیست

 حاشیه راست و چپ بوده باشد.از قبل بیشتر از فاصله مگر این که عرض جدول 
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با تنظیم اندازه هر  هر ستون را  به طور جداگانه می توان تنظیم کرد.(،Column widthعرض ستون)در •
کدام از ستون ها برای حفظ اندازه عرض جدول، مابقی مقدار عرض سایر ستون ‌ها تغییر می کند.

نکته

برای تنظیم اندازه ستون های و سطرهای یک جدول جدید، اغلب موشی  نسبت بMMه
محاوره ویژگی‌های جMMدول، کMMارایی بیشMMتری دارد و بMMرای تنظیم دقیMMق چیMMدمان از

سربرگ ستون‌ها و سربرگ جدول در محاروه ویژگی‌های جدول استفاده می شود.

درج سطرها و ستون‌ها
برای درج سریع سطر یا ستون، نشانگر موشی را روز سطر یا ستون قبلی یMMا بعMMدی مMMورد نظMMر قMMرار

می‌دهیم و برای درج سطر یا ستون به یکی از روش‌های زیر عمل می کنیم:
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یا Rows Above روی شwwمایلبرای درج سطر قبل یا بعد از سطر فعلی، از روی نوارابزار جدول یا نوار کنwwاری، •
Rows Below کلیک می کنیم 

Columnsروی شwwمایل  فعلی، از روی نwwوارابزار جwwدول یwwا نwwوار کنwwاری، سwwتون قبwwل یwwا بعwwد از سwwتونبwwرای درج •

Above  یا Columns Below. کلیک می کنیم 

Tableاز منwwوی  •  >  Insert  >  Rows  Above/Below یا Table  >  Insert  >

Columns Before/After

Insertکلیwwک راسwwت و انتخwwاب  •  >  Rows Above/Below  اwwی Insert  >  Columns

Before/After

برای درج چندین سطر یا ستون:

نشانگر موشی را روی سطر یا ستون مد نظر قرار می دهیم(5

 <  ستون‌ها…  یا با کلیک راست وTable > Insert یا طرها . . .  < سTable > Insertاز منوی  (6
(  باز می۳۰ستون‌ها...، پنجره محاوره ای کوچک)مشابه شکل  < Insert یا  سطرها…  < Insertانتخاب  

شود.

  مشخص می‌کنیمNumberتعداد سطر یا ستون مد نظر را در کادر (7

( یا  بعد)Abow/Before همچنین موقعیت سطر یا ستون های جدید را  مشخص تایید می کنیم، تا  قبل)(8
Below/After.ایجاد شود )
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نکته

سطر یا ستون های جدید به هر روشی که اضافه شوند، قالب بنMMدی مشMMابه سMMطر و
ستونی که نشانگر موشی در آن قرار دارد را خواهدداشت.

حذف سطر و ستون‌ها
برای حذف سریع  یک یا چند سطر یا ستون، سطر یا ستون های مورد نظMMر را انتخMMاب و بMMه یکی از

روش‌های زیر عمل می کنیم:

Deleteشwwمایل  روی •  selected  rows اwwی Delete  selected  columnsوارابزارwwروی ن 
جدول یا پانل جدول نوارکناری کلیک می‌کنیم.

 را انتخاب می‌کنیم.ستون <Deleteیا  < سطر Deleteکلیک راست ‌می‌کنیم و •

 را انتخاب می‌کنیم.ستون <Deleteیا  < سطر Delete  ریزمنویTableاز منوی •

ادغام یا تفکیک سلول‌ها
ادغام سلول ها معمولا برای سطر اول لازم می شود که  سرستون های جدول هستند و برخی مربMMوط

به بیش از یک ستون است.

برای ادغام یک یا چند سلول در یک سلول:

سلول هایی که می خواهیم ادغام شود را انتخاب می کنیم و یکی از راه های زیر را انجام می دهیم:

 را انتخاب می کنیم.(Merge Cells ادغام سلول ها) نوار منو Table از  منوی •

 را انتخاب می کنیم.(Merge Cells ادغام سلول ها)کلیک راست می کنیم و از منویی که باز می شود،•

روی نوارابزار جدول، کلیک می کنیم.( Merge Cells ادغام سلول ها)روی شمایل •

 کلیک( Merge Cells ادغام سلول ها)از قسمت جدول  پانل خصوصیات جدول در نوار کناری روی شمایل •
می کنیم

به این ترتیب همه محتوی سلول ها در یک سلول قرار خواهد گرفت.

برای تفکیک سلول ها نیز چندین راه وجود دارد:
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ابتدا نشانگر موشی را در سلول مورد نظر قرار می دهیم

 را انتخاب می کنیم.(spilt Cells سلول ها )...تفکیک  نوار منو Table از  منوی •

 را انتخاب می کنیم.(split Cells سلول ها)...تفکیک کلیک راست می کنیم و از منویی که باز می شود،•

روی نوارابزار جدول، کلیک می کنیم.( split Cells سلول ها)...تفکیک روی شمایل •

 کلیwwک(split Cells C سلول ها)تفکیک روی شمایل قسمت جدول  پانل خصوصیات جدول در نوار کناری از •
می کنیم

 باز می شود که در آن چگونگی تفکیک را در آن مشخص۳۱به این ترتیب محاوره ای مشابه شکل 
می کنیم. یک سلول می تواند افقی)به چند سطر( یا عمودی) به چند ستون( تفکیک شود.

نکته

بهتر است ادغام یا تفکیک سلول ها بعد ازتکمیل قالب بندی و سایر موارد مربوط به
قMMالب بنMMدیچیدمان جدول انجام شود. چراکه ممکن است ادغMMام و تفکیMMک کMMار 

جدول را با سختی مواجه کند.
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مشخص کردن کناره‌های جدول
کناره‌ه.ا)ما می‌توانیم خیلی سریع، تغییراتی روی کناره‌های جMدول  را بMا اسMتفاده از شMمایل هMای 

Borders (سبک کناره ،)Border Style)(و رنگ کناره Border color)از روی نوارابزار 
از(Borders  کناره‌ه@@ا)جدول یا پانل جدول نوار کناری اعمال کنیم.برای کنترل بیشMMتر، از سMMربرگ

(استفاده می کنیم.۳۲محاوره خصوصیات جدول)شکل 

مان طور که در شکل مشاهده می شود در این محاوره، بودن یا نبودن کناره‌ها، در سطر ها یا سMMتونه
(،paddingها، سبک، رنگ و ضخامت خط)کناره(، فاصله متن از بالا، پایین، چپ و راست هر سلول)

(، قابل تعیین است.Shadowسایه جدول)، رنگ و موقعیت سبک

انتخاب پس‌زمینه 
پس زمینه یک جدول می توان بسیار خوانایی جدول را بهبود ببخشد، )مثلا مشخص کردن عنوان ها
و سلول‌های خاص( یک جذابیت جدول را بیشتر کند.ما می‌توانیم دو نوع پس زمینMMه بMMرای سMMلول،

سطر یا کل جدول انتخاب کنیم.پس زمینه تک رنگ، پس زمینه گرافیکی.
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ما می‌توانیم به سرعت با استفاده از جعبه های گزینه ها روی شمایل رنگ پس زمینه سMلول جMدول)
Table Cell Background Colorروی نوارابزار جدول  یا پانل جدول از دسته خصوصیات ) 

.برای کنMMترل بیشMMتر، از سMMربرگنوار کناری، رنگ پس زمینه را روی سلول های جدول اعمال  کنیم
(استفاده می کنیم.۳۲از محاوره خصوصیات جدول)شکل پس‌زمینه 

ایجاد یا اعمال سبک‌های جدول

برای استفاده از سبک‌های جدول، ما می توانیم فقط با چند کلیک قالبی را به جدول اعمال کنیم.
شبیه سایر سبک‌ها، سبک‌های جدول ما در ثابت نگه داشتن ظاهر جداول در یک سند کمک

می‌کند.
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اعمال یک سبک جدول
AutoFormatبرای اعمال یک سبک جدول، با کنترل بیش تر،  سبک‌های قالب بنMMدی خودکMMار  )

Styles را )(از منوی جدولTable روی نوار منو یا شمایل)انتخاب می‌کنیم. روی نوارابزار جدولآن 
(، از فهرست یMMک قMMالب را انتخMMاب می کMMنیم و  در ادامMMه۳۴در محاوره قالب‌بندی خودکار)شکل 

ویژگی‌هایی از قالب  ]مثل قلم، ترازبندی، حاشیه ها و …[ که  می‌خواهیم بMMه جMMدول اعمMMال شMMود را
مشخص و تایید می کنیم.

نکته

ما می‌توانیم  قالب بندی که به طور دستی روی یک جMMدول اعمMMال کMMرده ایم را بMMه
قالب های موجود از طریق دکمه افزودن اضافه کنیم.

 ( -سبک‌هاDefault Table Styleهمچنین می‌توانیم -غیر از سبک پیش فرض)
(از فهرست حذف کنیم.Deleteرا با کلیک روی دکمه حذف) 

( تغییر دهیم.Rename نام سبک ها را نیز می‌توانیم با کلیک روی دکمه تغییر نام)
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ترازبندی عمودی
به طور پیش فرض، متن های داخل جدول از سمت چپ و بالای سلول تراز)شروع( می‌شMMود. البتMMه
می‌توانیم این پیش فرض را برای همه سلول‌های جدول یا سلول‌ها انتخMMابی تغیMMیر دهیم؛ مثلا ممکن

است بخواهیم متن هم از چپ و راست و هم از بالا و پایین در وسط سلول های جدول باشد.

برای تراز کردن عمودی متن در سلول‌های خاص به ترتیب زیر عمل می‌کنیم:

نشانگر موشی را در سلول مورد نظر قرار می دهیم یا چندین سلول را انتخاب می‌کنیم.(1

Align Top, Centerروی یک شمایل از نوار ابراز جدول کلیک می کنیم.)تراز از بالا، از وسط یا از پایین: (2

Verticallyا, ی Align Bottom)

وارد کردن داده و دستکاری آن در جداول

حرکت کردن در میان سلول‌ها
 بین سMMلول‌هاTabداخل یک جدول، ما می توانیم با استفاده از موشی، کلیدهای جهMMتی، یMMا کلیMMک 

جابه‌جا شویم.

با کلیدهای جهتی چپ و راست همان طور که می دانید نشانگر موشی یک نویسه به چپ یMMا راسMMت
جابه‌جا می‌شود اما اگر سلول خالی باشد یا نویسه ای باقی نمانده باشد به سلول کناری خواهMMد رفت.

کلید جهتی بالا و پایین هم ما)نشانگر موشی( را به سلول‌های بالا و پایین می‌برد.

 هم به طور مستقیم ما را به سلول بعدی حرکت می‌دهد و اگMMر بMMه آخMMرین سMلول جMدولTabکلید 
 نشMMانگر موشMMی را بMMه سMلول قبلی Shift+Tabرسیده باشیم، سطر جدید ایجاد می‌کند. فشMردن  

برمی‌گرداند.

نکته

)پرش یا درج چندین فاصله( استفاده کنیم،Tabاگر بخواهیم از خاصیت عادی کلید 
 می‌فشاریم.Tab را به همراه Ctrlکلید 
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را می فشMاریم. اگMر سMلول فعMال)سMلولی کMه در آن Ctrl+Homeبرای رفتن به ابتMدای جMدول، 
 ما را به ابتدای سلول می برد و فشMMردن دوبMMاره آن مMMا را بMMه این کلیدمیانبر خالی نباشد (قرارداریم

ابتدای جدول می‌برد.)فشردن مجدد این کلید چنانچه در ابتدای جدول باشیم ما را به ابتدای سMMند
(منتقل می‌کند

عملیات بیشتر روی جدول

تفکیک جدول
یک جدول می تواند به دو جدول تفکیک شود و دو جدول می توانMMد در یMMک جMMدول ادغMMام شMMود.
جداول به طور افقی قابل تفکیک هستند: سطرهای بالا در یک جدول قرار می گیرد و سطرهای پایین

در جدولی دیگر.

برای تفکیک یک جدول:

 مورد نظر برای جداسازی جدول قراردهید.)سلول های بالا در جدول دیگر قرار خواهد گرفت.سلولنشانگر موشی را در (1

 را انتخاب می کنیم.Split Table  در نوار منو یا شمایل مربوطه روی نوارابزار جدول، Tableاز منوی (2

محاوره تفکیک جدول باز می شود تا در خصوص تصمیم گیری درباره سرستون جدول کمکمان کند.(3

 سرستون جدول تفکیک شده یا بدون سرستون( را انتخاب و تایید می کنیم. در نتیجه جدولرونوشتحالت مورد نظر)(4
به دو جدول جدا شده  با یک بند خالی ، تفکیک می‌شود.

ادغام جداول
برای ادغام دو جدول:

 باید استفاده کنیم – نه دکمهDeleteابتدا بند یا بندهای بین دو جدول باید حذف شود.)برای انجام این کار از دکمه (1
(-Backspaceپس‌بر)

یک سلول از جداول را انتخاب می کنیم.(2

 را انتخاب می کنیم.(Merge Table ادغام جدول)  روی نوار منو،Tableاز منوی (3
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حذف جدول
برای حذف یک جدول، از هر یک از راه‌های زیر می توانیم عمل کنیم:

  را انتخاب می کنیم.Table  در منوی باز شده Deleteروی یک قسمت از جدول کلیک راست می کنیم و از •

  را انتخwwابTable  و سwwپس Delete  در نوار منwwو Tableروی یک قسمت از جدول کلیک می کنیم و از منوی •
می‌کنیم.

  را از نوارابزار جدول  انتخاب می‌کنیم.Delete  Table  شمایل روی یک قسمت از جدول کلیک می کنیم و •

 راBackspace یwwا Deleteاز انتهای بند قبل از جدول یا ابتدای بند بعد از جدول را انتخwwاب می‌کwwنیم و دکمwwه •
می‌فشاریم.

یادداشت

روش چهارم بند قبل و بعد جدول را نیز ادغام می‌کند که ممکن اسMMت مطلMMوب مMMا
 بندها را دوباره جدا کنیم.Enterنباشد. بنابراین بعد از حذف می توانیم با فشردن 

رونوشت یک جدول
برای رونوشت یک جدول از قسمتی از جدول به قسمت یا سندی دیگر:

جدول را انتخاب می‌کنیم.(1

2)Ctrl+C را می‌فشاریم یا روی شمایل Copy.روی نوار ابزار استاندارد کلیک می‌کنیم 

جایی که می‌خواهیم جدول در آن جا رونوشت شود کلیک می‌کنیم.(3

4)Ctrl+V را می فشاریم یا روی شمایل Paste.روی نوار ابزار استاندارد کلیک می کنیم  

جابه جایی جدول
جدول را انتخاب می‌کنیم.(1

2)Ctrl+X را می‌فشاریم یا روی شمایل Cut.روی نوار ابزار استاندارد کلیک می‌کنیم 

 شود کلیک می‌کنیم.منتقلجایی که می‌خواهیم جدول در آن جا (3

4)Ctrl+V را می فشاریم یا روی شمایل Paste.روی نوار ابزار استاندارد کلیک می کنیم  
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یادداشت

Alt+Enterبرای درج بند قبل از جدول به ابتMMدای جMMدول می رویم و بMMا فشMMردن 

بندی قبل از جدول ایجاد خواهدشد. برای درج یک بند بلافاصله پس از جدول نMMیز
 می‌زنیم.Alt+Enterبه انتهای جدول می رویم و 

73 | عملیات بیشتر روی جدول



راهنمای شروع به کار با لیبره آفیس-رایتر

۵فصل 
چاپ



فوریچاپ 

Printاگر شمایل چاپ مستقیم)  DirectlyکMMروی نوار ابزار قابل مشاهده باشد می توانیم با کلی )
روی آن، همه سند را به طMMور مسMMتقیم بMMا تنظیمMMات پیش فMMرض چMMاپ)بMMدون مشMMاهده و تغیMMیر
تنظیمات(، چاپ کنیم.اگر شمایل چاپ مستقیم دیده نمی‌شود می توانیم آن را با کلیک راسMMت روی

Visibleنوار ابزار و کلیک روی دکمه های نمایان)  Buttons(تقیمMMاپ مسMMاب چMMو سپس انتخ )
Print Directly.ظاهر کنیم ،)

File←منو پرونده   تنظیمات چاپگر)ما می توانیم از   >  Printer  Settings)اپگر پیشMMچ ، 
←ابزاره..ا   کنیم.این تنطیمات از منویتعیینفرض و تنظمیات دیگر را در محاوره تنظیمات چاپگر 

چاپ) رایتر  ←گزینه‌ها  ←Tools > Options > LibreOffice Writer > Print)در هم   
← ابزاره..ا  گزینه‌ه..ا دسترس است؛ تنظیمات عمومی بیشتر نMMیز از   ← چ..اپ)لی..بره آفیس←

Tools > Options > LibreOffice  > Print .) کتاب اصلی-۲۰برای اطلاعات بیشتر فصل 
شخصی سازی رایتر- را مطالعه بفرمایید.

کنترل چاپ

File > Print، Ctrl+P( ,+⌘P←برای کنترل بیشتر روی چاپ، از محاوره چاپ)پرونده چاپ،  

( روی نوار ابMMزار اسMMتاندارد اسMMتفاده می‌کMMنیم.Print( یا شمایل چاپ)وی سیستم عامل مکینتاشر
ظاهر محاوره چاپ روی سیستم عامل مک متفاوت است و ممکن است شامل کنترل‌هMMای اضMMافه‌تر

چاپ است که در این فصل توضیح داده نمی شود.
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محاوره چاپ دو سربرگ دارد، که در هر کدام می‌توانیم به‌گونه‌ای کMMه در بخش‌هMMای بعMMدی شMMرح
داده می‌شود، طیفی از گزینه ها را انتخاب کنیم.

انتخاب گزینه های معمول چاپ
 محاوره چاپ می توانیم انتخاب کنیم:Generalدر سربرگ 

( را، از فهرست چاپگرهای در دسترس.printerچاپگر)•

چنwwدبارکدام صفحات چاپ شوند، تعداد رونوشت هwwای چwwاپ و چگwwونگی چwwاپ رونوشwwت هwwا) یعwwنی اگwwر از صwwفحات •
همه صفحات چاپ شود و بعد چاپ تکرار شود یا هر صفحه به تعداد مورد نظر ما چwwاپ شwwود وخواستیم چاپ بگیریم، 

  (Range and copiesقسمت سپس صفحه بعد  چاپ شود- 

 (Page Layoutاندازه و جهت ]عمودی یا افقی [کاغذ )قسمت •

 (Page Layoutچه تعداد صفحه در یک ورقه کاغذ چاپ شود)قسمت •
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 چاپ به صورت بروشور باشد؟آیا•

 صفحات که بیرون می‌آید،مرتب کردنآیا صفحات معکوس) از انتها به ابتدا( چاپ شود؟)در مورد برخی از چاپگرها در •
کاربرد دارد( 

انتخاب چاپگر و گزینه‌های چاپ ارسال شده
( کلیMMک کنیMMدتاProperties ، روی دکمه ویژگی هMMا)General روی سربرگ Printerدر قسمت 

 انتخاب کنیم: جهت صفحه را،توانیممحاوره ویژگی‌های چاپگر انتخابی ظاهر شود، یعنی جایی که می‌
،  و اندازه کاغذ برای چاپ روی آن.مورد استفاده راسینی کاغذ

 پایین محاوره چاپ کلیک می کنیم تا انتخاب کنیم خروجی چاپ چند نسخه به صورتmoreروی 
مقابله ای باشد یا تجمیعی، به عبارت ساده تر این که  اگر از صفحات چندبار خواستیم چاپ بگیریم،
همه صفحات چاپ شود و بعد چاپ تکرار شود یا هر صفحه به تعداد مMMورد نظMMر مMMا چMMاپ شMMود و

سپس صفحه بعد  چاپ شود.) اگر فقط یک سری چاپ مد نظر باشد این گزینه کارکردی ندارد(

چاپ چندین صفحه در یک ورقه یا کاغذ
ما می‌توانیم چندین صفحه از یک سند را در یک ورقه یا کاغذ چاپ کنیم. برای این کار، در قسMMمت

Page  Layout از سربرگ  General روی ، more دادMMکلیک می کنیم و از فهرست کشویی تع
صفحه برای چاپ روی هر ورقه کاغذ را انتخاب می‌کنیم. پانل پیش‌نمایش کنار محاوره چاپ نشMMان

می‌دهد که سند چاپ شده چطور به نظر خواهد رسید.

موقعی که بیش از دو صفحه در یک ورقه قرار است چاپ شود، ما می‌توانیم ترتیب یMMا چینش افقی و
 را نشان می دهد.مقادیر مختلف و قابل انتخاب  78عمودی صفحات را انتخاب کنیم. شکل 
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انتخاب این که چه چیزی چاپ شود
غیر از این که چاپ همه سند، ما می توانیم انتخاب کنیم، صفحه یا صفحات یا قسمت انتخابی

خاصی از سند، چاپ شود.

چاپ یک صفحه منحصر به فرد:

 را انتخاب می کنیم. کادر متنیPages  ، گزینه Range and Copiesدر محاوره چاپ، در قسمت(5
روبروی آن شماره صفحه فعلی را نمایش می‌دهد.

شماره صفحه‌ای که می‌خواهیم را چاپ شود را وارد می‌کنیم. در کادر پیش‌نمایش کناری، صفحه انتخابی نشان داده(6
می‌شود.

چاپ محدوده‌ای از صفحات:

 را انتخاب می کنیم. کادر متنیPages  ، گزینه Range and Copiesدر محاوره چاپ، در قسمت(1
روبروی آن شماره صفحه فعلی را نمایش می‌دهد.

 یا ترکیبی(۱،۳،۷،۱۱ یا ۱-۴شماره صفحاتی که می خواهیم چاپ شود را وارد می کنیم) به عنوان مثال (2

چاپ یک متن یا گرافیک انتخابی:

در سند، مواردی که می‌خواهیم چاپ شود را انتخاب می‌کنیم و سپس محاوره چاپ را بازمی‌کنیم.(3

 فعال است. در کادر پیش‌نمایش مواردSelection  ، گزینه Range and Copiesحالا در قسمت(1
انتخابی ما نمایش داده می‌شود.
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LibreOffice Writerانتخاب‌های روی سربرگ  

LibreOfficeدر سربرگ   WriterکلMMش( ه ای از79MMاپ زیرمجموعMMاره چMMواانیم دربMMا می تMMم ،) 
محتواها) به عنوان نمونه عکس ها یا متن های ناپیدا( تصمیم بگیریم در خصMMوص چMMاپ متMMون بMMه
رنگ مشکی )حتی اگر رنگی برای متن تعریف شده باشد(، چاپ خودکار صفحات خMMالی درج شMMده)

inserted blank pages.نحوه و جای چاپ توضیحات ،)

برخی انتخاب ها ممکن است در همه زمان ها فعال نباشد. مثلا اگر سند ما شامل توضیحی نباشد،
  غیرفعال خواهد بود.Commentsفهرست کشوبی 
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چاپ یک بروشور
در رایتر، ما می‌توانیم یک سند را با دو صفحه روی هر طرف یک ورقه چاپ کنیم به طوری که وقتی

ورقه را از وسط تا می کنیم، صفحات ترتیب درستی برای جزوه یا بروشور داشته باشند.

نکته

سند خود را طوری طراحی کنید که در چاپ با نصف اندازه هم خوب به نظر برسMMد؛
بهبرای انتخاب حاشیه‌های مناسب، اندازه قلم‌ها و دیگMMر مMMوارد ممکن اسMMت نیMMاز 

د.داشته باشیتجربه 

برای چاپ یک بروشور روی یک چاپگر یک طرفه:

 محwwاوره چwwاپ، روی  کلیwwک(General سwwربرگ عمwwومی) (�� Page Layoutدر قسwwمت چیwwدمان صwwفحه )(1
تغییر می کند تا توالی صwwفحاتی کwwه قwwرار اسwwت چwwاپ شwود را نشwwان دهwwد.می‌کنیم و  را انتخاب می‌کنیم. پیش نمایش 

( 80شکل )
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←ابزارها گزینه‌ها تنظیمات زبان زبان‌ها یاوابسته به تنظیمات زبانی ما)(2 ← ← Tools > Options >

Language Settings > Languagesمحاوره چاپ ممکن است شامل منوی کشویی روی دکمه ،)
بروشور باشد. یعنی اگر زبان ما فارسی نبود انتخابی بین راست به چپ یا چپ به راست بودن بروشور نداشتیم.

( را انتخاب می کنیم و برایEven pages ،‌چاپ صفحات زوج)Range and Copiesدر قسمت (3
چاپ روی تایید کلیک می کنیم.

کاغذهای چاپ شن هاده را از چاپگر خارج کنید و آن‌ها را در جهت درست به چاپگر برگردانیدتا روی سمت خالی چاپ(4
 جهت و چیدمان صحیح  کاغذها نیاز به تجربه داشته باشید.پیدا کردنشود. ممکن  است برای 

( را انتخاب و تاییدOdd pagesصفحات فرد) Range and Copies روی محاوره چاپ، در قسمت (5
کنید.

 نکته

د)دوبلکس(،چاپ کنMMاگر چاپگرمان بتواند به طور خودکار روی هر دو طرف کاغذ را 
۵و۴در گام سوم همه صفحات را برای چاپ انتخاب و تایید می کMMنیم و از گام‌هMMای 

صرفنظر می‌کنیم.

پیش نمایش صفحات قبل از چاپ
نمای عادی صفحه در رایتر  هر صفحه را شبیه آنچه چاپ خواهدشد، نشان می‌دهد؛  مMMا در این نمMMا
می توانیم در این نما ویرایش انجام دهیم.اگر بخواهیم سندی را بMMرای چMMاپ روی دو طMMرف کاغMMذ
طراحی کنیم، ممکن است بخواهیم صفحات در آن حالت را هم ببینیم. رایتر برای این منظMMور دو راه

فراهم کرده است:

( روی نوارBook View ()نمای قابل ویرایش(: استفاده از دکمه نمای کتاب)View Layoutچیدمان نما)•
وضعیت 

)نمای فقط خواندنی((Print Previewپیش نمایش چاپ)•
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 چاپ:پیش‌نمایشبرای استفاده از 

یا روی شمایلا انتخاب می‌کنیم ( رFile > Print Preview←از نوار منو،  پرونده  پیش‌نمایش چاپ )(1
Toggle Print Preview  روی نوار ابزار استاندارد کلیک می‌کنیم، یا Ctrl+Shift+O می‌فشاریم. رایتر

به جای نوار ابزار قالب بندی، نوار ابزار پیش نمایش چاپ را نشان خواهدداد.

شمایل پیش‌نمایش مورد نیاز را انتخاب می کنیم: تک صفحه‌ای، دو صفحه ای، پیش‌نمایش کتاب یا چندین صفحه )(2
Single Page, Two Pages,  Book Preview ,یا Multiple Pages.)

برای چاپ سند از این نما، روی شمایل چاپ کلیک می کنیم تا محاوره چاپ باز شود. گزینه های چاپ را در صورت نیاز(3
تغییر می دهیم و روی تایید کلیک می‌کنیم.
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 چیست؟نامهادغام 

گاهی اوقات لازم می شود نامه ای مشابه  را برای چند گیرنده‌های مختلف بفرستیم. مثلا یک مMMدیر
بخواهد پیام تبریک سال نو را برای کارمندان خود ارسال کند. برای این موضوع نMMرم افزارهMMای واژه

 را پیش بینی کرده اند که بتوان متن کلی(Mail Mergنامه)پرداز حرفه ای مانند رایتر امکان ادغام 
نامه را تنظیم کنیم و با جزییات متفاوت نامه را در اختیار داشته باشیم.

 شرح داده خواهدشد. گام‌ها شامل موارد زیر است:نامهدر این فصل فرآیند ادغام 

ایجاد و ثبت منبع داده (4

ایجاد و چاپ فرم نامه‌ها، برچسب نامه و پاکت نامه(5

امکان ذخیره جداگانه یک خروجی قابل ویرایش به جای چاپ مستقیم.(6

ایجاد و ثبت یک منبع داده
همان طور که گفته شد برای اجزای متغیر نامه مانند نام گیرنده، نشانی و ….؛ نیاز به اتصال به یMMک
منبع داده داریم. لیبره آفیس برای ادغام پستی از دفترچه نشMMانی اسMMتفاده می کنMMد امMMا فیلMMدهای
دفترچه نشانی می تواند جابه جا شود یا حتی می توانیم از منبع داده ای دیگر با سرستون های کاملا

توانایی ایجاد پایگMMاه دادهلیبره آفیس متفاوت از دفترچه نشانی مانند صفحه گسترده استفاده کنیم. 
 را دارد. MySQLها از صفحات گسترده، پرونده های متنی و پایگاه داده هایی مانند 

برای دسترسی مستقیم به یک منبع داده از یک سند رایتر، آن منبع باید یک بار در لیبره آفیس ثبت
شده باشد. برای این کار:

←منوی پرونده  راهنمای گام به گام  منبعدر رایتر یا حتی مرکز شروع یا سایر برنامه های لیبره آفیس ، از (1 ←
( را انتخاب می کنیم.File > Wizards > Address Data Source )اطلاعات نشانی…

 مناسبنوع  ( در سیستم عامل های مختلف متفاوت است. 85انتخاب های موجود در اولین صفحه راهنما)شکل (2
 است)منبع داده بیرونی انتخاب مورد نظر  دیگر یک صفحه گستردهدفترچه نشانی بیرونی را انتخاب کنید.  برای  

Other external data source)

 می‌زنیم.Nextبر اساس انتخاب ما ممکن است فهرست مراحل تغییر کند. روی 
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 کلیک می کنیم.Settings( روی  85در صفحه بعدی )شکل (3

(Spreadsheet( را انتخاب می کنیم. در مثال ما صفحه گسترده )85 داده )شکل منبعدر صفحه ایجاد  نوع (4
  را کلیک می‌کنیم.Nextانتخاب ماست. 

85 | ایجاد و ثبت یک منبع داده

: انتخاب نوع دفترچه نشانی بیرونی۳۹شکل 

: شروع بخش تنظیمات گام به گام۴۰شکل 

: انتخاب نوع پایگاه داده۴۱شکل 



…  کلیک می‌کنیم و صفحه گسترده شامل اطلاعات مورد نظر خود راBrowse( روی 86در صفحه بعد )شکل (5
انتخاب می کنیم.

 کلیک می‌کنیم.Test Connectionبرای آزمایش این که اتصال به طور صحیح برقرارشده است روی دکمه (6

 کلیک می کنیم.Finishروی  (7

Field کلیک می کنیم. ما نیاز به کلیک روی دکمه تخصیص فیلد)Next ( روی 87در صفحه بعدی )شکل (8

Assignmentنداریم مگر زمانی که بخواهیم ادغام پستی را شروع کنیم و فیلدهای پیش فرض برنامه با )
سرستون های داده‌های ما متفاوت باشد.
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.( در فیلد موقعیت نشان داده شwwده اسwwت.odb (، نام و محل پایگاه داده جدید)87در صفحه عنوان منبع داده) شکل (9
 مشاهده می کنید ما می‌توانیم نام و محwwل نگه‌داشwwتن پایگwwاه داده را تغیwwیر دهیم؛ هم‌چwwنین87همان طور که در شکل

 و دیگwwر این کwwه  در سwwایر برنامwwه( شwwود.Embedجاسwwازی)می‌توانیم تعیین کنیم که این دفترچه نشانی در این سند 
های لیبره آفیس نیز در دسترس باشد یا خیر.

 کلیک می کنیم. منبع داده ثبت شد.Finishروی (10

87 | ایجاد و ثبت یک منبع داده

 نیستتخصیص فیلد: برای یک صفحه گسترده نیاز به کلیک روی ۴۳شکل 

: نام و پرونده دفترچه نشانی۴۴شکل 



ایجاد فرم نامه

( اسMMت امMMا سMMاده تMMرین وWizardیک روش ایجاد فرم نامه، ادغام پستی به صورت گام به گMMام )
 ایجاد فرم نامه به صورت دستی است که در این قسمت توضیح می‌دهیم:جامع‌ترین روش 

فرم کلی )فرم خام/اطلاعات ثابت( نامه را در یک سند خالی تنظیم می کنیم یا سندی که حاوی فرم نامه است را باز(1
می‌کنیم

 منابع Shift+Ctrl+F4( یا کلید ترکیبی View > Data Sources←از منوی نما  منابع داده )(2
داده‌های  ثبت شده را ظاهر می‌کنیم.

منبع داده ای که برای فرم نامه می خواهیم استفاده کنیم را پیدا می کنیم،‌پوشه اش وسپس پوشه جدول‌ها)(3
Tablesیا۱(  و سپس  کاربرگ مورد نظر) در مثال ما برگه sheet1را باز می کنیم . پرونده های داده‌ها نمایش  )

داده خواهدشد.

حالا فرم نامه را با نوشتن متن، علامت گذاری، قالب بندی  و… به صورت دلخوامان ایجاد یا ویرایش می‌کنیم.(4

برای اضافه کردن فیلد)مقادیری که به ازای هر نامه متفwwاوت خواهنwwدبود( بwwه جwwایی از نامwwه کwwه مwwورد نیwwاز اسwwت، روی(5
سرستون مورد نظر کلیک می کنیم و آن را به نقطه دلخواه در نامه می کشیم. در متن نامه بین فیلدها فاصwwله را فیلwwدها

را فراموش نکنید تا مقادیر مانند نام و نام خانوادگی به هم نچسبد.
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سند ما آماده چاپ شده است.(6

( را انتخ��اب می ک�نیم،File > Print← پرون�ده  چ�اپ)ن�وار من�و،، شمایل چاپ ی�ا از Ctrl+pبا ا(
 که می‌گوید سند ما حاوی فیلدهای پایگاه داده است و از م��ا تایی��دیم کرد مشاهده خواه89پیغامی مشابه شکل 

می خواهد که فرم نامه را با ادغام نامه ها می خواهیم یا خیر؟

ها چاپ شود یاسطر، می‌توانیم مشخص کنیم همه Recordsدر محاوره ادغام نامه)شکل (،در بخش ب(
 مشابه سایر نرم‌افزارهاShift یا Ctrlسطرهای انتخابی. برای انتخاب رکوردهای پراکنده می توانیم از کلید 

استفاده کنیم.برای محدوده خاصی از سطرها هم می توانیم شماره اولین و آخرین سطر مورد نظرمان را وارد
کنیم.

 انتخاب و تایید می کنیم. همچنینOutput را در قسمت Printer چاپگر، به مستقیم نامه ها ارسالبرای ج(
می‌توانیم سند ادغام شده را در یک سند چند صفحه ای یا چندین سند مجزا داشته باشیم. 

نکته

اگر در فایل منبع داده) در مثال ما صفحه گسترده( نام کاربرگ یا سرسMMتون‌ها تغیMMیر
کرد لازم است تغییرات را مجددا در سند اعمال کنیم.

89 | ایجاد فرم نامه

: کشیدن فیلدها به بدنه فرم نامه۴۶شکل 

: پیام تایید ادغام نامه۴۷شکل 



یادداشت

نوار ابزار ادغام نامه هم کمک خوبی برای پیش نمایش نامه ادغام شده و انجام امور
مربوط به ادغام و منابع داده هاست.

ذخیره سندهای ادغامی
ممکن است ترجیح ما این باشد که نامه‌ها را در یک پرونده ذخیره کMMنیم تMMا بتMMوانیم قبMMل از چMMاپ،

تصحیح و قالب‌بندی بیشتری داشته باشیم.برای این منظور:

Outputاز قسمت  را ( Fileپرونده)( رکودهای مورد نظر را انتخاب می کنیم و 90در محاوره ادغام نامه) شکل(1

انتخاب می کنیم تا گزینه های دیگری فعال شود.

ما می‌توانیم تعیین کنیم که خروجی در یک سند حاوی همه نامه ها ذخیره شود یا به صورت جداگانه ذخیره شوند؛ نوع(2
)پسوند( پرونده، محل ذخیره سازی و نام پرونده ها)همنام  سرستون مورد نظرمان( نیز توسط ما قابل تعیین است.

( کلیک می کنیم و بدین ترتیب سند ادغام شده بدون وابستگی به داده ها در اختیارمان خواهدبود.okروی تایید)(3
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